
Overview
 

 
Wall Control-red displays the desktop of the machine that is being controlled. It allows you to remotely display Vision, IP-
Camera and application windows across a network on another machine or locally on the same machine.

You can use Wall Control-red to interactively move, size and position application windows and control Vision and IP-Camera
windows by using the Windows Properties sheet. Wall Control-red also has a guide and grid function to aid the positioning of
windows.

Wall Control-red allows you to save specific wall layouts as .lay files enabling them to be re-called when required.

Wall Control-red also allows you to save Vision windows as templates called presets. New instances of the saved preset
windows can be created in subsequent layouts. Presets can also be used with the split windows functionality, this allows you to
divide a Vision window into a set of sub-windows, each displaying a cropped portion of the image in the original window.

There is an area of the application around the desktop where windows can be dragged allowing them to be manipulated without
being displayed on the video wall.

Icons Displayed in the Wall Control-red Application Toolbar

The Icons displayed in the application toolbar identify which type of source is available to each input:
 

 = Composite source
 

 = S-Video source
 

 = Analog source
 

 = Component source
 

 = DVI source
 

 = Dual-Link DVI source
 

 = SDI/HD-SDI/3G source
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= IP Camera source 

 
If an icon has a green surround  this indicates the type of source currently being captured for that particular input.
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Installation
Wall Control-red consists of two separate elements that work together to enable you to control the display wall, the Wall
Control-red Application and the Wall Control-red Server.

Wall Control-red Application

The Wall Control-red Application should be installed on the machine that has been identified to control the display wall. This
could be any machine on the network including the machine driving the display wall. The application element of Wall Control-red
is used to control the position, size and properties of each window displayed on the Server machine.

Wall Control-red Server

The Wall Control-red Server is used to display Vision and application windows. The Server element of Wall Control-red needs
to be installed on the machine from which you wish to create Vision and application windows.

Note: 
If you are using the Wall Control-red hardware key for the first time, it should not be inserted into your USB port until
the installation of the application is complete. The operating system will not recognise the device and will allocate a
generic driver.

To install Wall Control-red, browse and locate the INSTALL.EXE, double click on the install icon and the installation wizard will
be activated.

The first dialogue displays details of compatible operating systems. Click Next> to continue and the Licence Agreement
dialogue is displayed. To proceed with the application installation the terms of the License Agreement must be accepted
by clicking on the acceptance box.

Once the Licence Agreement has been accepted click Next>. 

Note: 
If you are using the Wall Control-red hardware key for the first time, it should not be inserted into your USB
port before you get to this stage of the installation. The operating system will not recognise the device and will
allocate it a generic driver.

The hardware key must remain in the USB port after installation otherwise the advanced Wall Control-red features will not
function.

Wall Control-red will, by default, be installed in Program Files; the Destination dialogue can be used to select a different
location for installation by clicking on Browse… Once the required location has been selected Click Next> to continue.

 The next dialogue displays the name of the folder where the Wall Control-red application shortcuts will be created. The
name of the folder can be changed to suit requirements. Click Next> to continue to the Application/Server dialogue.

 The Application/Server dialogue enables you to select which elements of Wall Control-red are installed on a particular
machine.  

Wall Control-red Server

The Wall Control-red Server is used to display Vision and application windows. It should be installed on the machine that
contains the relevant hardware.

Wall Control-red Application 

The Wall Control-red Application is used to control the position, size and properties of each window displayed on the Wall
Control-red Server machine. The Wall Control-red Application should be installed on the machine you wish to use to
control the display. This could be any machine on the network or the same machine as the Wall Control-red Server. Click
Next> to continue to the Components dialogue.

Use the Components dialogue to select which components of Wall Control-red you wish to install. Click Next> to
continue to the Install dialogue.

The Install dialogue displays a summary of the options you have selected during installation. If you wish to change any of
the options, use the <Back button and locate the option you wish to change. Once the correct options have been
selected, click Next> to install Wall Control-red. 

 Wall Control-red has now been installed; Click Finish and a prompt to reboot your machine will be displayed.
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Hardware Compatibility
Wall Control-red is designed for use with the following hardware:

ImageDP4

Image4

VisionRGB-X2

VisionRGB-E1

VisionRGB-E2

VisionSD8

VisionSD4+1

VisionDVI-DL

VisionSDI2
 
 

ImageDP4

 
ImageDP4 operates under Windows® Vista/XP/7 and spreads the Windows desktop across the multi-screen display. Both
portrait and landscape display configurations are supported. Ideal for video wall and digital signage applications.

For information on how to correctly install and set up the card, refer to the User Manual

 

Image4

 
Image4 operates under Windows® Vista/XP/7 and spreads the Windows desktop across the multi-screen display. Both portrait
and landscape display configurations are supported. Ideal for video wall and digital signage applications.

For information on how to correctly install and set up the card, refer to the User Manual

VisionRGB-E1

 
 
The VisionRGB-E1 is a PCI-e x4 low profile single channel capture card. It displays the output from one video source as a
window on the desktop of your PC.
 
Wall Control-red is able to launch, configure, format the input sources and also move and re-size the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.

VisionRGB-E2

 
The VisionRGB-E2 is a PCI-e x4 dual channel capture card. It displays the outputs from two video sources as windows on the
desktop of your PC. 
 
Wall Control-red is able to launch, configure, format the input sources and also move and re-size the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.
 

VisionSDI2

 
The VisionSDI2 is a PCI-e x4 dual channel Serial Digital Interface capture card that supports SD-SDI, HD-SDI and 3G-SDI.
 
The VisionSDI2 is able to launch, configure, format the input sources and also move and resize the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.
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display wall. For information on how to correctly install the card, refer to the User Manual.

VisionRGB-X2

 
 
The VisionRGB-X2 is a powerful analog capture card for the desktop PC. It displays the output from two video sources as
windows on the desktop of your PC. Two separate analog data sources can be connected simultaneously with the ability to
switch between them quickly and easily.

Wall Control-red is able to launch, configure, format the input sources and also move and re-size the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.

 

VisionSD8

 
The VisionSD8 is a PCI-e x4 eight channel video capture card. It displays the output from one video source as a window on the
desktop of your PC.  
 
Wall Control-red is able to launch, configure, format the input sources and also move and re-size the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.
 

VisionSD4+1

 
The VisionSD4+1 is a PCI-e x4 four channel video capture card and a single channel RGB,DVI capture card. It displays the
outputs from two video sources as windows on the desktop of your PC.  
 
Wall Control-red is able to launch, configure, format the input sources and also move and re-size the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.

VisionDVI-DL

 
The VisionDVI-DL is a PCI-e x4 single channel Dual-Link DVI capture card. It displays a single dual link video source on the
desktop of your PC.
 
Wall Control-red is able to launch, configure, format the input sources and also move and re-size the Vision window on the
display wall. For information on how to correctly install the card, refer to the User Manual.
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IP-Camera
Wall Control-red is designed to allow you to view IP-Camera streams that use compatible network protocols 1. Wall Control-red
is pre-configured for use with a list of recommended IP-Camera sources.

Axis 210

Axis 233D Network Dome

Axis Q4701 Encoder

Bosch NWC-0455 Dinion

Bosch VideoJet X10

Bosch VideoJet X20

Bosch VIP X1600 XFM4

Bosch VIP X1600 M4SA

Mitsubishi NM-C130FD

Moxa VPort 354 Video Encoder – 1

Moxa VPort 354 Video Encoder – 2

Moxa VPort 354 Video Encoder – 3

Moxa VPort 354 Video Encoder – 4

Panasonic WV-NP304

Axis 233D Network Dome

Axis Q4701 Encoder

Siqura encoder S60E - MPEG4

Siqura encoder S60E - H.264

Siqura HD62 - MPEG4

Siqura HD62 - H.264

TEST MODEL

Test Model

The Test Model is a default installed on the Render Station to enable the user to test the connectivity to the Render Station. For
instructions on configuring the Test Model see Troubleshooting.

Wall Control-red can also be configured to support other models of IP-Camera, including those from additional manufacturers
2.

Before any IP-Camera windows can be opened the user must add and configure one or more Render Stations 2. Render
Stations display outputs must be connected using DVI cables to a VisionRGB-E2 contained in the Wall Control-red server. The
outputs from the Render Station are captured and displayed using the VisionRGB-E2 hardware. VisionRGB-E2 cards assigned
to the capture of Render Stations are no longer available as Vision inputs.
 
Once the Render Station has been configured the cameras can be added via the IP-Camera option on the Configure menu 2.
The process of configuring cameras involves choosing the manufacturer and model of the IP-Camera, along with its network IP
address or host name.
 
Notes:
 
1. Real Time Streaming Protocol (RTSP)
2. Dependent on the type of Wall Control-red Licence purchased
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Networking
If you intend to allow access to your Wall Control-red Server across a network you will need to:

Decide on a security policy for the connections.

Configure Wall Control-red.

Configure your Operating System.
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Security Policy
In order for a user to connect to a Wall Control-red server, the server must be listening on at least one port. These ports have a
potential vulnerability. If your server is working in a secure environment, you probably don’t need to worry about unauthorised
access to the ports. If your Wall Control-red server is on a network that is generally accessible, you will probably want to restrict
access to the ports.

By default, Wall Control-red will require that users who connect to a port on the Wall Control-red server provide a user name
and a password. The user name and password must correspond to an account on the Wall Control-red server or if the Wall
Control-red server is participating in a domain, an account on the domain.

To access the Wall Control-red Administrator dialogue select:

Start/All Programs/Wall Control-red/ Wall Control-red Administrator

Note: To use the administrative dialogue you must be a member of the Administrator Group.

 

 

Use the dialogue to select the level of security you require, if, as stated above, your Wall Control-red server is working in a
secure environment then you may wish to allow network connections without the need to authenticate.

If the Wall Control-red server is on a generally accessible network then you may wish to select the Use Windows user
accounts to authenticate connections option.

Once Network Access has been determined, click on OK and re-boot for the changes to be applied.

You must be a member of the Administrator group to run the Wall Control-red Administrator program.
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Operating System Configuration
Wall Control-red works with the following Operating Systems:

Windows® XP and Windows® XP Service Pack 1

Windows® XP Service Pack 2

Windows® Server 2003/2008

Windows® 7
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Windows® 7
If the Wall Control-red server is not participating in a domain, you will need to change the Inbound Rules.

Prior to carrying out this procedure, ensure that a network cable is plugged in to your machine.

Open the Control Panel and click on Windows ® Firewall, the following dialogue is displayed:

 

 
Click on Advanced settings to open the Advanced Setting dialogue.
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Click on Inbound Rules to open the Inbound Rules dialogue:

 

 

Locate all Wall Control-red settings and ensure each one is active (has a green icon). The Profile should = Domain, Enabled
should = Yes and Action should = Allow.
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To unblock or allow a broken connection, double click on the specific Inbound rule to open the Properties dialogue and on the
General tab select Allow the connection and click on Apply as shown in the following dialogue:

 

 

Once all the Inbound Rules have been established, ensure the Network cable is plugged into your machine and then re-install
Wall Control-red
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Windows® XP and Windows® XP Service Pack 1
If the Wall Control-red server is not participating in a domain, you will need to change the way network logons that use local
accounts are authenticated. Network Authentication.
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Windows XP® Service Pack 2 and Windows Server® 2003/2008
Network Logons

If the Wall Control-red server is not participating in a domain, you will need to change the way network logons that use local
accounts are authenticated. Network Authentication.

If password protection is enabled, accounts for users must have passwords.

Blocking

If Wall Control-red is installed on Windows XP® Service Pack 2 or Windows Server® 2003 the install program automatically
configures the firewall.

The firewall needs to be configured manually if you upgrade to Windows XP® Service Pack 2 after Wall Control-red has been
installed.

As each component of Wall Control-red tries to access the network, the firewall will display a dialogue:

Select the Unblock option in each dialogue to allow Wall Control-red to work correctly.

Changes made take effect immediately.

Components that must access the network are:

wallctl

rgbxsvr

appsvr

ipcamsvr
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Network Authentication
If a Windows XP® machine is not participating in a domain, there are two ways it can treat network connections:

Classic - local users authenticate as themselves.

Guest only - local users authenticate as Guest.

The default configuration is Guest only - local users authenticate as Guest.

In order for Wall Control-red to be able to authenticate users, your system must use Classic - local users authenticate as
themselves.

For more information, search for Network Access: Sharing and security model for local accounts in Windows XP® Help
and Support.

To change the configuration to Classic - local users authenticate as themselves.

Open Control Panel in Classic View and select Administrative Tools.

Select Local Security Policy and the following dialogue is displayed:

 

 

Expand Local Policies in the left panel.

Select Security Options.

Scroll down the options and locate Network access: Sharing and security model for local accounts as shown below:
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Double click on the Network access: Sharing and security model for local accounts string and the following dialogue
is displayed:

 

 

Select Classic - local users authenticate as themselves from the dropdown menu and click on Apply then OK.
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Running the Wall Control-red Application
How to Launch the Wall Control-red Application

Connect to a Wall Control-red Server

Creating Windows

Moving Windows

Changing Window Properties

Saving a Layout

Loading Layout File

Saving a window as a Preset 

How to Launch the Wall Control-red Application

Click on the Windows Start button and select All Programs/Wall Control-red. From the Wall Control-red menu, select Wall
Control-red  and the following dialogue is displayed:

 

 

Connect to a Wall Control-red Server

If the Wall Control-red application and Wall Control-red server are installed on the same machine then select Wall Control-red
– My Computer from the programs menu, alternatively, double click My Computer in the Machines list on the Wall Control-
red application Toolbar.

The Machines list shows the Wall Control-red Servers that have previously been connected to.

The Layouts list shows the most recently used layout files. Double click to open the selected file.

Details of how to connect to the server can be found HERE .

Creating Windows

Once a connection to the server has been established then windows can be created for display.

Windows can be created using the New menu or the application Toolbar.
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By using the New menu the following windows can be created and displayed:

Vision  - A Vision output can be displayed if a Vision card is installed

Preset - A preset window can be displayed providing a Vision card is installed in the system and one or more Vision
windows have been saved as presets.

Application – Windows based applications can be opened and displayed eg. VNC Viewer, Picture.exe, Microsoft
Powerpoint, DGCPlay.

 

Select Wall Control-red from the Configure menu to capture the desktop and display in the Wall Control-red application
window.

Using the Wall Control-red application Toolbar, you can select a particular device or input:

 

 

The application Toolbar displays a list of the type of windows that can be opened, depending on the hardware you have
installed in your machine. Use the drop down menus to select the required inputs for display.

To open the required inputs:

Select the required input using the cursor and drag to a preferred position on the wall.

Double click on the required input and the window will open, positioned at the top left of the display wall.

Open multiple inputs by pressing the shift key and clicking the required number of inputs with the mouse.

Using the Define Grid function, the widows can be placed in a specific position using a 3-pixel width snap-to-grid functionality.

Moving Windows Around the Display Wall

Setting up a video wall requires windows to be moved on the desktop. All types of window can be moved in the same way.

Using the Window Properties

Windows can also be moved using the Window Properties dialogue. Using the Position controls Top and Left the windows
can be placed anywhere on the display wall.

Using the Mouse
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Use the mouse to select the window in the Wall Control-red application; by keeping the left mouse button pressed, the window
can be dragged to any preferred position on the wall. Used in conjunction with Grids and Guides, the window can be placed in
an exact position.

Again, by using the mouse, right click over the window in the Wall Control-red application and select Move. This allows you to
move the window around the display wall without depressing the mouse button. To release the window in a preferred position,
click the left mouse button.

Changing Window Properties

The properties of a window can be changed using the Windows Properties, Input Settings and On Screen Display
Properties dialogs.

The Window Properties allow you to change the position of the window, the size and aspect ratio, the style, caption title and the
window ID.

The Input Settings allow you to change the appearance of a Wall Control-red inputs using the Input, Cropping and Display
setting controls.

The On Screen Display Properties allows you to configure the display type, text and font details of the on screen display.

Saving a Layout

When your display wall has been configured i.e. all the required windows have been opened and positioned, you may wish to
save the layout. Wall Control-red allows you to save the layout as a .lay file and store it on your machine for future use.

To save a layout use the File menu on the Wall Control-red Application and select Save or Save As..

Only the full version of Wall Control-red allows you to save layout files.

Loading Layout Files

To load a saved layout file:

File Menu

With the Wall Control-red application open, select the File menu and then Open… You will be asked if you wish to save the
changes you have made. Browse to the layout file you wish to load and select Open. The layout will be opened and the
windows positioned on the display wall.

Saving a Window as a Preset

Once a window has been configured and the window properties and cropping have been set, the window can be saved as a
preset. The presets are saved with a .WCP file extension in a folder called Preset Windows inside the directory where Wall
Control-red Server was installed.

To save an Vision window as a preset, select a displayed Vision window and then select Save as Preset from the Window
menu. Alternatively, right click on the Vision window and select Save as Preset .
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Menu Options
The Wall Control-red Application has six menu options:

File

New

Layout

Window

Tools

Configure

Help
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File Menu
The File menu allows you to manage layout files and connections.

New

Opens a new (empty) layout file.

Open

Opens an existing layout file.

Save

Saves the current layout.

Save As

Saves a layout with a specific name and location.

Connect

Connects the application to a specific machine.

Disconnect

Closes the current connection

Most recently used files

List of the most recently used layout files. Selecting one of these files opens it.

Exit

Closes the application.
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New
When New is selected:

A prompt is displayed asking if any changes to the current layout are to be saved.

If changes are to be saved, click Yes and follow the steps detailed in Save/Save As

If changes are not required to be saved click No

The windows on the machine close.

The image of the desktop from the machine will continue to be displayed.

The New option is only available when connected to a machine.
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Open
When Open is selected:

A prompt is displayed asking if any changes are to be saved.

Browse to the layout file to be opened.

When a layout file has been located and selected, the following takes place:

If a current active connection is being used and the selected layout file is for a different computer, the following dialogue is
displayed.

 

Select Cancel and the operation is terminated.

Select OK:

If Close Windows is selected, all windows are closed and the connection is terminated.

Previously Saved Layouts

When opening a previously saved layout the following dialogue will be displayed should an error occur:

 

 

The dialogue displays details of any errors found by the application when opening a layout.

Use the up/down arrows to scroll through the displayed text.

Click on the Save As… button to save the information as a text file for later use or to assist in support queries.
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Save/Save As
Save:

Select Save to save the current layout.

If the layout has not been previously saved, i.e. it is a new layout then the Save As dialogue is displayed.

Browse to the folder where the layout is to be saved, enter a File name and click on Save.

Save As:

Select Save As to save a layout with a specific name to a particular location using the displayed dialogue.

Note: This function is only available if there is an active connection.
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Connect
Select Connect and the following dialogue is displayed:

 

 

Use this dialogue to specify which machine is to be controlled using the Wall Control-red application

Use the drop down arrow to display a list of the most recently selected machines; the list will include My Computer which can
be used to connect to the machine where the Wall Control-red application is running.

The machine can be specified by name or by IP address.

Select Browse… to locate a machine on the local network.

Windows

Add existing windows to representation:

Displays the open windows.

Close existing windows:

Will close all Wall Control-red managed windows.

Click on OK to connect to the selected machine.

 

 

If you connect to a machine that has been configured to authenticate connections, you will be required to provide a user name
and password. The user name and password must be for an account machine you are connecting to or on the domain if the
machine is part of a domain.
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If the above error message is displayed one of the following problems has occurred:

The user name, the password or the machine/domain that you have entered are not correct. Try entering the details
again.

If the machine to which you are connecting is running Windows XP® Service Pack 2 and you have not entered a
password, you will need to change your account so that you have a password.

If the machine you are connecting to is running Windows XP® and it is not participating in a domain, you will need to
change the Network Logon settings on the machine. Network Authentication.

You can create a shortcut on your desktop that specifies the machine and your user name. When you double click on this
shortcut, it will take you straight to the Logon dialogue for you to enter your password.
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Disconnect
This option is only available when a connection is active.

When Disconnect is selected, the following dialogue may be displayed, depending on how Wall Control-red has been
configured.

 

 

The dialogue offers two selections.

Leave windows open:

Leaves open all windows that Wall Control-red manages.

Close windows:

Closes all windows that Wall Control-red manages.

If any changes to the layout have been made a Save prompt will be displayed.
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Recent Files
Most Recently Used File List:

The File Menu contains a section where the six most recently used files are displayed, the most recent at the top of the list. By
selecting a particular file, the layout is re-loaded.

To select a file simply click on it or press the corresponding number on your keyboard.

If a file is selected that no longer exists then the file name will be automatically deleted.
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Exit
Select Exit to close the application.

 

31 / 155



New Menu
The New Menu displays options for each window category.

Preset Windows

Opens a new Preset Window

Vision Window

Opens a new Vision Window

IP-Camera Window

Opens a new IP-Camera window

Run Application

Opens the Run Application dialogue
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Preset Windows
When Preset Window… is selected from the NewMenu the following dialogue is displayed: 
 

 
The New Preset Windows option will not be available unless a Vision card is installed and preset windows have been
previously saved.
 
Use the drop down list to select the preferred Preset Window and click on OK. A Vision window with the same window settings,
input properties and on screen display that was saved as a preset is created and displayed in the top left of the display.
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Vision Window
When Vision Window… is selected from the NewMenu the following dialogue is displayed:
 
 

 
 
Use the drop down list to select the preferred Vision input and click on OK.
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IP-Camera Window
When IP-Camera Window… is selected from the New menu then one of two actions will occur. If no IP-Cameras have been
configured then the following message is displayed.

 

Select Yes to display the IP-Camera configuration dialogue where you will be able to add and configure new IP-Cameras for
use in Wall Control-red.

If one or more IP-Cameras have been configured, the following dialogue is displayed.

 

Use the drop down list to select the preferred IP-Camera window and click OK.
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Run Application
When Run Application… is selected from the New menu the Run Application dialogue is displayed. The dialogue has two
tabs, Application and Application Input.

 

Application

 

 

Application

The full path of the Application executable must be specified.

You can select the Application as follows:

Use the drop down list to select a configured Application to run.

Click on the Browse button to select a new Application

Type in the full path of the Application executable

Command line

Use the Command line edit box to specify parameters for the Application. Many Applications accept the name of a file to be
opened. For details of command line arguments, refer to your Application documentation.

Start in folder

The Start in folder is the folder in which the Application is run.

If a Start in folder is not specified, the application will run in the folder in which it resides.

With Run Application, Wall Control-red can launch any application. Unfortunately, each application works in its own way so the
exact outcome when you launch an application varies.

Application Command Line

The Command Line window displays the full Command Line that will be passed to the Wall Control-red.
 

Application Input
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The Application Input dialogue allows the user to identify and select Applications created in the Configure Application
dialogueue.

Application

Use the Application drop down list to select the required Application. The list will only display those Applications that have been
configured on the system.

Input

When the Application has been selected, use the Input drop down list to select the required input associated with the
Application.

Switches

Once the Application and input have been selected the Switches edit box is automatically populated with the switches for that
specific application.

Path

Once the Application and input have been selected the Path edit box is automatically populated with the path to the application.

Command Line

The command line window displays the resulting command from the switches and path edit boxes. The command is executed
by clicking the Run button.
 
A new input can be created by editing the Input drop down list. Type in the name of the new input and edit the path or browse to
a new file in the Path edit box. By clicking on the Run and Save button the new input will run and be saved on the system.  The
new input with be displayed in the input window on the Configure Application dialogueue.
 
This dialogueue cannot be used to modify and save an existing input.
 
Any modifications to the Switches edit box will result in the Run and Save button being disabled irrespective of other changes
made to any other controls on this dialogueue.
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DGCPlay
DGCPlay is a utility that will play movie files including WMV, MPEG, and AVI depending on the codecs installed on the system.
Some media will require additional codecs not installed as standard components of Windows.
 
To activate the DGCPlay application open Run Application from the New Menu by specifying Dgcplay.exe as the target followed
by the command line options separated by spaces. The Dgcplay.exe will be located in the Wall Control-red folder
 

Command Line Options

Nomenclature  
Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

 

–path=media file path

 
-Window=[left],[top],[width],[height]

Change the position and size of the window.

All the values are optional but the commas must be used.

 
-WindowStyle={BorderAndTitleBar|BorderOnly|NoBorderOrTitleBar}
 
-repeat={Yes|No}
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Picture.exe
Picture.exe is a utility that is used to display static pictures in any format supported by Windows® i.e. BMP, JPG, PNG etc 
To activate the Picture application open Run Application from the New Menu by specifying picture.exe as the target followed by
the command line options separated by spaces. The picture.exe will be located in the Wall Control-red folder
 

Command Line

In the Run Application dialogue:

In the Application box put the full path of the Picture application.

For example:

C:\Program Files (x86)\Wall Control\picture.exe
In the Command Line box put the full path of the file. For example:

–file=”C:\Users\Public\Pictures\Sample Pictures\koala.jpg” –xpos=0 –ypos=0 –width=2800
–height=2100 –caption=”Title Bar Caption”
If the file name or path contains spaces, enclose the path in quotes.

-file = name of the file to display

-xpos|-ypos = number

To define the position of the top left corner

-width|-height = number

To define the size of the window

-caption = text

Enter text for the description in the Title Bar. By default the picture is displayed without a border or title bar
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RealVNC Viewer
When you run RealVNC Viewer it will display a dialogue asking you for a RealVNC server and then display another dialogue for
a password for that server. You may not be able to respond to these dialogues.

Once a connection has been made using RealVNC Viewer, you can save the connection details to a configuration file. The
configuration file can be specified on the command line allowing RealVNC Viewer to run without displaying any dialogues.

Saving the Configuration File:

Connect to the machine you wish to view with RealVNC Viewer.

Click on the icon at left end of the title bar to display the menu.

Select Save connection info as…

Choose a file name and a folder and click on Save.

You will be asked Do you want to save the password to this file? Click on Yes.

Using the Configuration File

In the Run Application dialogue:

In the Application box put the full path of the RealVNC viewer application.

For example:

C:\Program Files\RealVNC\vncviewer.exe
In the Command Line box put /config followed by the full path of the configuration file. For example:

/config "C:\Documents and Settings\User\ My Documents\file.vnc"
If the configuration file name or path contains spaces, enclose the path in quotes.
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Microsoft PowerPoint®
To open a PowerPoint presentation as a slide show use the following command line:

/s "C:\Documents and Settings\User\My Documents\presentation.ppt"
If the presentation file name or path contains spaces, enclose the path in quotes.

For a slide show to continue cycling through the slides, the PowerPoint window must be the active window.

Only one PowerPoint application can be running at a time. If you try to start PowerPoint while it is already running, the second
PowerPoint sends a message to the first and then exits.

When a layout file is opened, Wall Control-red closes the windows and applications it is responsible for and then creates the
windows specified in the layout file. The windows and applications are sent messages to close them. The PowerPoint
application is run to create a PowerPoint window.

If the existing PowerPoint application has not finished closing by the time Wall Control-red tries to open the new presentation, it
is possible that a message to open a new PowerPoint presentation and a message to close are sent to the existing PowerPoint
application. The result is that PowerPoint closes.
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Layout Menu
The Layout Menu enables you to create grids, rulers and guides in the Wall Control-red application.

Create Guide

Define Grid

Clear Guide

Clear all Guides

Snap Sensitivity
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Create Guide
Select the Create Guide option and the following dialogue is displayed:

 

 

Select the Orientation, either horizontal or vertical. Use the up/down arrows to adjust the position of the guide i.e. the number
of pixels from the top for vertical or left for horizontal then click on OK. A guide is then created at the specified position.

You can also create a guide by clicking on one of the rulers.
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Define Grid
Using the Define Grid option, a grid may be placed over the representation to assist in the positioning of windows. The grid
has a three pixel snap-to-grid functionality.

 

 

Using the up and down arrows, select the size of grid required.

Pixels

The grid can be defined by pixel size i.e. 150 x 150 pixels.

Divisions of a desktop

This option will divide the desktop into equal sized rectangles depending on the number of divisions selected.

When the correct grid spacing has been selected, click on OK and a grid will be displayed in the representation window.

To re-set a defined grid you must first select the Clear all Guides option otherwise the previous grid will remain displayed.
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Clear Guide
Right click on a guide in the ruler and select this option to clear the guide.
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Clear all Guides
The Clear All Guides option removes all guides from the Wall Control-red application window.
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Snap Sensitivity
The snap sensitivity dialogue allows you to customize the sensitivity of the snap-to-grid functionality for the current connection.
 

 
The sensitivity value effects the distance that representation windows need to be moved in order to snap to the nearest guide.
The closer the sensitivity is to the maximum value 10 then the stronger the snap effect will be.
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Window Menu
The options contained in the Window menu will not be activated unless windows are displayed in the application.

 

Window Properties

Input Settings

Carousel Settings

On Screen Display

Split into Sub-Windows 1

Audio Settings

Restore

Move

Size 

Minimise

Maximise

Close

Windows

 

1. The Split into Sub-Windows function only applies to Vision windows.
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Restore
This option restores the current window. This option is only available when the window is minimised or maximised.
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Move
The selected window can be moved using the keyboard interface of the representation. This option is not available when the
window is minimised or maximised.
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Size
The size of the selected window can be changed using the keyboard interface of the representation. This option is not available
when the window is minimised or maximised.
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Minimise and Maximise
Minimise

Selecting this option minimises the selected window and an icon representing the minimised window is displayed in the bottom
left corner of the representation.

Maximise

Selecting this option maximises the window across the desktop of the target machine.
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Close
Select this option to close the selected window.
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Windows
Selecting Windows… from the Windows Menu displays the following dialogue:

 

 

The Windows dialogue displays a list of the windows being controlled by the Wall Control-red application.

If you click on a single window in the list, you can activate or close the window using the buttons.

If you click on multiple windows with the Ctrl key held down, you could close the selected windows by clicking on the Close
button.

Click on OK to close this dialogue.
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Window Properties
Selecting Window Properties from the Window Menu will display a properties dialogue box relevant to the type of window
currently active:

Vision Properties

Application Properties

IP-Camera Properties
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Vision Window Properties
 
The Vision Window Properties sheet enables you to change the appearance of the Vision window. When the required changes
have been entered, click on OK for the changes to take effect.

Select "Window Properties" with a Vision Window activated and the following dialogue is displayed.

 

 

The Vision Window Properties dialogue has the following groups:

Position

Size

Aspect Ratio

Style

Cursor

Window ID

Caption

Invalid Input

Capture Format

Deinterlace
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Transfer Data

Scaling

Capture Rate

 

Position

The position of the selected Vision window can be adjusted to suit your requirements.

Top and Left

Using the up and down arrows the selected Vision window can be positioned anywhere on the desktop. The values are in
pixels. The value Top = 0 and Left = 0 will position the Vision window in the top left corner of the desktop. When the required
values have been entered, click on Apply and the changes will take effect.

Size

The size of the selected Vision window can be adjusted to suit your requirements.

Width and Height

The required width and height of the Vision window can be determined by using the up and down arrows. The values are in
pixels.

If Exclude borders is selected then the numbers in the "Width" and "Height" controls will not include the borders, title bar and
menu, only the active area within the application window.

Aspect Ratio

Maintain aspect ratio enables the data to be resized by changing the height; the width is adjusted automatically so that the
aspect ratio is maintained.

Do not maintain aspect ratio

Selecting Do not maintain aspect ratio enables the selected Vision window to be resized to any rectangular configuration
without constraints.

Maintain aspect ratio of source

Checking the Maintain aspect ratio of source button will preserve the aspect ratio of the source captured by the Vision card
in your machine.

If Cropping is not enabled on the Input Properties sheet then the "Width" and "Height" values displayed in the Capture
Settings group on the Input Properties sheet are used to reflect the aspect ratio.

If Cropping is enabled then the Width and Height values in the cropping dialogue are used as the aspect ratio.

Maintain aspect ratio

If you select Maintain aspect ratio you can specify the aspect ratio you would like the Vision window to have.

When the required values have been entered, click on Apply or OK and the changes will take effect.

Style

The appearance of the Vision window can be changed to suit your particular requirements:

Border and title bar

Select this option to display the border and title bar of the active Vision window.

Border only
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Select this option to display the Vision window with just a border. In this state, the Vision window may still be resized using the
borders.

No border or title bar

Select this option to display the source only. The Vision window can only be resized by using the Size and Position function as
described above. See "How To Re-size a Window".

Click on Apply or OK and the style chosen will take effect.

Show menu bar

Select to display the Vision window menu bar.

If you want to restore the menu bar you can access the Window Properties sheet by right clicking in the Vision window and
selecting Window Properties from the menu. Show menu bar can then be selected.

Always on top

If the Always on top option is selected the windows will be displayed in front of all others windows that are not always on top.

Cursor

Always Show

Always shows the cursor in the client area of the window.

Always Hide

Always hides the cursor in the client area of the window.

Hide when window active

Only hides the cursor in the client area of an active window. If the window is divided using the split screen function, the cursor is
visible in all sub-windows that are not active.

Window ID

Use the up/down arrows to select a required Window ID. The Window ID identifies a window enabling it to be modified from
the command line. See Command Line Interface.

Caption

The Caption edit box can be used to change the caption in the title bar of the selected Vision window.

Variables

The Variables function is a means of displaying a changeable value in the title bar.

 

Invalid Input

Should the source become disconnected, switched off, changed to a mode that is out of range of the Vision capture card and
no frames are being captured you have the option to:

Display message after - milliseconds

If you want to be made aware that the source cannot be captured then you can display a message informing you that no signal
is being received.

 

Capture Format

This option allows you select the pixel format you wish use. The Capture Format has an effect on the performance of a
system.

Automatic
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Select Automatic and the data is captured in the same pixel depth as the desktop.

5-5-5 or 5-6-5

If either of these options is selected, the format will be captured at 16 bit. For most systems this is by far the most efficient

8-8-8

If this option is selected then the format will be captured at 32 bit.

Deinterlace

 
Deinterlace is only available if an interlaced source is being captured.
 

Bob

Bob is more suited to captures displaying motion and offers a higher frames per second.
 

Weave

Weave is more suited for images captured with little or no motion, any change in the captured image will cause artifacts known
as tearing.
 

None

Only a single field will be displayed.

 

Transfer Data

The Transfer Data section allows you to select which route captured data follows before it is displayed.

Direct to graphics card

Select Direct to graphics card and depending on the availability of off screen memory the captured data will be transferred
direct to the graphics card without passing through the system main memory. If there is not enough off screen memory, the
captured data will be transferred via system memory.

Via system memory

Select Via system memory if you want the data to be transferred to main memory before being transferred to the graphics
card.

 

Scaling

The capture is scaled when the size of the interior of the Vision window is different from the size of the data you are capturing.
The Scaling options allow you to choose how the capture is scaled.

Scaling Down

If Fast (default) is selected, the scaling down is performed before the data is transferred across the PCI bus.

If Slow (high quality) is selected, the captured data is transferred across the PCI bus without being scaled.

Scaling the capture down before transferring it across the PCI bus reduces the PCI bandwidth required.

If the capture is being transferred direct to the graphics card, the graphics chip does the scaling. The scaling algorithm used by
the graphics chip is better than the scaling algorithm used on the Vision capture cards.

If the RGB data is being transferred to system memory, the display driver does the scaling using a halftone algorithm. The
quality of the scaling and speed with which it is done will depend on the display driver and graphics card being used.
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Scaling Up

The captured data is transferred across the PCI bus without being scaled.

If the captured data is being transferred direct to the graphics card, the graphics chip does the scaling up. There is no
difference between Fast (default) and Slow (high quality).

If the capture is being transferred to system memory, the display driver does the scaling. The Fast (default) and Slow (high
quality) options allow you to choose between an ordinary algorithm and a halftone algorithm respectively. The quality of the
scaling and speed with which it is done will depend on the display driver and graphics card being used.

Capture Rate

The Capture Rate control gives a degree of control over the capture rate by enabling you to select the percentage of frames to
be captured from the source. 100% is the default capture rate.

For example:

If the refresh rate is 60Hz, selecting a capture at 15% will capture a maximum of 9 frames per second (FPS), selecting 10%
will capture a maximum of 6 FPS.

If a capture rate of 100% is selected, an attempt is made to capture as many frames as possible. In this instance, the capture
may be directed to the buffer at the same time as the buffer is being displayed. This can sometimes cause a single horizontal
tear on moving images in the Vision application window.

A different capture rate can be selected for when the Vision window is inactive. This enables system resources to be managed
more efficiently. Reducing the percentage of frames captured for an inactive window will free more system resources for other
tasks.

Select Capture at____ when window is inactive and use the drop down menu to select the capture rate used when the
window is inactive.
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IP-Camera Window Properties
The IP-Camera Window Properties sheet enables you to change the appearance of the IP-Camera window.
 
Select "Window Properties" with an IP-Camera window activated and the following dialogue is displayed.

 

 
Any changes made to the settings on the Windows Properties sheet will not take effect until the Apply button has been clicked. 

When the IP-Camera Properties dialogue is displayed, the IP-Camera window is disabled, preventing other users from
modifying or closing it.

The IP-Camera Window Properties sheet has the following groups:

Position

Size

Aspect Ratio

Style

Window ID

Caption

Position

The position of the selected IP-Camera window can be adjusted to suit your requirements.

Using the up and down arrows the selected IP-Camera window can be positioned anywhere on the desktop. The values are in
pixels. The values Top = 0 and Left = 0 will position the IP-Camera window in the top left corner of the desktop (or Primary
Monitor). When the required values have been entered, click on Apply and the changes will take effect.

Size

The size of the selected IP-Camera window can be adjusted to suit your requirements.

Width and Height
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The required width and height of the overlay window can be determined by using the up and down arrows. The values are in
pixels.

If Exclude borders is selected then the numbers in the Width and Height edit boxes will not include the borders, title bar and
menu, only the active area within the application window.

Aspect Ratio

Maintain aspect ratio keeps the width and the height of the displayed data in the same ratio. For example, if the width of the
window is changed, a corresponding change is made to the height of the window.

Style

The appearance of the IP-Camera window can be changed to suit your particular requirements:

Border and title bar

Select this option to display the border and title bar of the active IP-Camera window.

Border only

Select this option to display the IP-Camera window with just a border. In this state, the IP-Camera window may still be resized
using the borders however the window can only be dragged across the desktop using the IP-Camera window representation in
the Wall Control-red application.

No border or title bar

Select this option to display the overlay source only. The IP-Camera window can only be resized by using the Size and
Position function as described above.

Click on Apply or OK and the style chosen will take effect.

Show menu bar

The Show menu bar control allows you to show or hide the window menu bar. You can access the menu for the window by
right clicking on the window.

Always on top

If the Always on top option is selected the window is displayed in front of all other windows that are not always on top.

Window ID

Use the up/down arrows to select a required Window ID. The Window ID is not displayed anywhere in the application window; it
is used in conjunction with creating shortcuts.

Caption

The Caption edit box can be used to change the caption in the title bar of the selected IP-Camera window.

Variables

The Variables function is a means of displaying a changeable value in the title bar.
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Application Window Properties
Accessing Application Properties

Select Window Properties... with an Application window activated and the following dialogue is displayed.

 

 

When this dialogue is displayed, the application window is disabled preventing other users from modifying or closing it.

Size and Position

The size and position of the window can be entered manually. The position values are relative to the top left corner of the
desktop.

Style

The Style options can be used to alter the border style of the window, for example, select the Border only option and the title
bar will not be displayed, select the No border or title bar and the application only is displayed.

The Show menu bar option allows you to hide the menu bar.

If the Always on top option is selected the window is displayed in front of all others windows that are not always on top.

Caption

The caption box displays the title of the application window.

Window ID

Use the up/down arrows to select a required Window ID. The Window ID identifies a window enabling it to be modified from the
command line.
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Accessing Window Properties
There are various ways to access the Window Properties page, select from the following:

In the Wall Control-red application, with the window active, open the Window menu and select Window Properties…
from the list of options.

In the displayed window, open the Window menu and select Window Properties…

In the Wall Control-red application, place the cursor over the representation of the Window and click the right mouse
button. Select Window Properties… from the list of options.

Place the cursor over the active Window on the desktop, click the right mouse button and select Window Properties…
from the list of options.

In the Wall Control-red application, if a window has been minimized an application icon will be displayed in the Wall
Control-red application bar. Place the cursor over the application icon and right click the mouse button. Select Window
Properties… from the list of options.
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Accessing Application Properties
There are various ways to access the Application Properties page, select from the following:

In the Wall Control-red application, with the Application window active, open the Window menu and select Window
Properties… from the list of options.

In the Wall Control-red application, place the cursor over the representation of the Application Window and click the right
mouse button. Select Window Properties… from the list of options.

In the Wall Control-red application, if a window has been minimized an application icon will be displayed in the Wall
Control-red application bar. Place the cursor over the application icon and right click the mouse button. Select Window
Properties… from the list of options.
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How to Re-size a Window
The Windows can be re-sized in various ways depending on the style setup on the Window Properties sheet.

If the window has a border and title bar:

Using the mouse, click on the top, bottom, left or right of the window border. The cursor will change to a size cursor as
shown below:

Use the mouse to drag the border until the required size is achieved.

 

 

Press the Alt key and spacebar on the keyboard with the Vision Window active and a menu is displayed as follows:

 

 

Select Size from the menu options and the cursor will change to a cross hair cursor and displayed in the centre of the Vision
window:

 

 

Use the cursor keys to resize the window.

Use the command line interface -Window as described in the Command Line Interface topic for the particular window
type.

Access the Windows Properties sheet and re-size the window using the Size controls.

The application can also be re-sized in the Wall Control-red desktop representation.
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If the window has no title bar or border:

Use the command line interface -Window as described in the Command Line Interface topic.

Access the Windows Properties sheet and re-size the Vision window using the Size controls.

The application can also be re-sized in the Wall Control-red desktop representation.
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How to Re-position a Window
Windows can be re-positioned anywhere on the desktop. This can be achieved in a number of ways depending on the style
setup.

If the window has a border and title bar:

Using the mouse, position the cursor on the title bar as shown below.

Press and hold the left mouse button and drag the window to the required position.

 

 

Press the Alt key and spacebar on the key board with the window active and a menu is displayed as follows:

 

 

Select Move from the menu options and the cursor will change to a cross hair cursor and displayed in the centre of the
window:

 

 

Use the cursor keys to move the Window to the required position.

Use the Command Line Interface -window as described in the Command Line Interface topic for the particular window
type.

Access the Windows Properties sheet and re-position the window using the position controls.
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Vision Variables
The Variables function is a means of displaying a changeable value in the title bar. For example, if you select the Input variable
the current input source is displayed. If the input source is changed, the title bar is updated automatically to reflect this.

 

 

Select the variables you wish to display on the title bar from the list available and click on OK. The Input variable is selected as
a default.

The % sign displayed in the Caption edit box is used to separate the variables.

Preset filenames

The Preset filename edit box allows you to select the filename (without suffix) that will be used to save the preset for the
specific sub-window selected in Window number. The preset filenames must be unique with respect to each other. If the input
variable is inserted into the Preset filename for a specific sub-window then it will be substituted with the name of the input itself
before the preset is saved.
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IP-Camera Variables
The Variables function is a means of displaying a changeable value in the title bar. For example, if you select the Input variable
the current input source is displayed. If the input source is changed, the title bar is updated automatically to reflect this.

 

 

Select the variables you wish to display on the title bar from the list available and click on OK. The Input variable is selected as
a default.

The % sign displayed in the Caption edit box is used to separate the variables.
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Input Settings
Selecting Input Settings from the Windows menu will display the Input Settings dialogue relevant to the type of window currently
active:

Application Input Settings

Vision Input Settings

IP-Camera Input Settings
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Vision Input Settings
Accessing the Input Settings.
 
The Input Settings sheet allows you to control how the source is captured and displayed in the Vision window. All the controls
on this sheet are interactive; therefore, any changes made are shown when the next frame of data is displayed in the Vision
window.

There are two types of Input Setting sheets in the Vision application; RGB/DVI capture and Video capture.

RGB/DVI

 

Video Capture
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The Vision Input Settings sheet has the following groups:

Source

Capture Settings

Resolution and Refresh

Cropping

Video Adjustments

Colour Adjustments

 

Source

The Source control specifies which source is displayed in the window. Select the input from the drop down list. You can give
the inputs meaningful labels in the Configure Vision dialogue.

When you change inputs, the Capture Settings controls may change.

See the Vision User Manual for information on the input connections.

Capture Settings 

 

Share these capture settings across all inputs.

With Share these capture settings across all inputs selected, the changes you make to the capture settings controls will be
shared with other inputs of the same type. The capture settings will also be saved automatically so that the next time a Vision
window is created, the capture settings can be used.

Use these capture settings with this input only.

With Use these capture settings with this input only selected, the changes you make to the capture settings controls will
be applied to this Vision window only.  
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be applied to this Vision window only.  

Reset 

The Reset button will discard any changes you have made to the capture settings and display the source with default settings.

Resolution and Refresh

Width

The width specifies the horizontal resolution of the source.

Height

The height specifies the vertical resolution of the source.

Vertical Refresh

The Vertical Refresh specifies the vertical refresh rate of the captured source.

Cropping 

The cropping controls allow you to display a specific area of the signal within the Vision window. The co-ordinates are relative to
the start position defined by Horizontal Position and Vertical Position.

For a single Vision window, a different cropping area is remembered for each video mode. If the source being captured
changes, a different cropping area is used.

If the source is VGA, the Overscan radio button can be selected. Overscan automatically configures the best cropping values
for displaying the full input signal.

 

Video Adjustments

The Video Adjustment controls describe the video timings being used to capture the source. Ideally, the values should match
the video timings of the source.

Horizontal Position

The Horizontal position specifies the offset, in pixels, from the end of the horizontal sync to the start of the active video.

Horizontal Size

The Horizontal size specifies the total number of pixels used to sample lines within the source. This includes the active portion
of video and blanking.

Phase

If the captured image is noisy, it may be that the signal is being sampled close to the transition between pixels. The Phase
control allows you alter the point at which the signal is sampled. You can think of it as a fine horizontal position control. This
control is not available when composite or S-Video is being captured.

Vertical Position

The Vertical position specifies the offset, in lines, from the end of the vertical sync to the start of the active video. This control is
not available when composite or S-Video is being captured.

Black Level

At the beginning of each line the source must be sampled to measure the black level. This sample is used as a reference for
determining the brightness of the pixels on the line. The Black Level control allows you to specify the position at which the black
level of the signal is sampled. This control is not available when composite or S-Video is being captured.

Note: The Video Adjustment settings are not available when a DVI source is being captured.

Video Standard

Select the required video standard from those available in the drop down menu.
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Equalisation

When using the VisionDVI-DL the Equalisation function becomes available. The VisionDVI-DL supports longer input cable
lengths (up to 20m). Use the Boost slider to increase signal strength for longer input cables.
 

Colour Adjustments

Brightness

The Brightness control allows you to brighten or darken the capture.

Contrast

The Contrast control allows you to alter the difference between the light parts of the capture and the dark parts of the capture.

Colour Domain

The Colour Domain control allows you to change the detected colour domain format for the capture input. In some instances
the driver may incorrectly detect the colour space, the Colour Domain control enables you to override it.

Saturation

The Saturation control allows you to increase or decrease the saturation

Hue

The Hue control allows you to increase or decrease the hue. This is only available for NTSC captures.
 
Click on the Colour Balance… button to change the colour balance for the specified input connector. This function is only
available when capturing analog sources.

Note:
All Colour controls are the only ones available when a DVI source is being captured., The Red, Green and Blue controls are for
RGB analog only.
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IP-Camera Input Settings
Accessing the IP-Camera Input Settings

The Input Settings sheet allows you to control which input is used to display the source shown in the window. It also displays
information about the source resolution for the currently selected IP-Camera.

 

Source

The source control specifies which input is used to display the source shown in the window. Select the name of the input from
the drop down list.

When a new input is selected there may be a slight delay while the source is initialized. There will also be a further delay before
the resolution information is displayed for the new source.

Resolution

These controls display information about the source resolution.

Width

The width specifies the horizontal resolution of the source.

Height

The height specifies the vertical resolution of the source.
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Colour Balance
The Colour Balance dialogue allows you to change the colour balance for an input connector.

 

 

All controls in this dialogue box are interactive so the changes you make will be seen when the next frame of data is displayed
in the Vision window.

All Colours

The Brightness and Contrast controls alter the settings for all colours. These are the same as the Brightness and Contrast
controls in the Vision Input Settings sheet.

Red

The red controls allow the brightness and contrast of the red part of the Vision signal to be adjusted a small amount relative to
the over all brightness and contrast settings.

Green

The green controls allow the brightness and contrast of the green part of the Vision signal to be adjusted a small amount
relative to the over all brightness and contrast settings.

Blue

The blue controls allow the brightness and contrast of the blue part of the Vision signal to be adjusted a small amount relative to
the over all brightness and contrast settings.

Reset

The Reset button will set all the values to the default settings.
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Accessing Application Input Settings
There are various ways to access the Application Input Settings page, select from the following:

In the Wall Control-red application, with the Application window active, open the Window menu and select Input
Settings… from the list of options.

In the Wall Control-red application, place the cursor over the representation of the Application Window and click the right
mouse button. Select Input Settings… from the list of options.

In the Wall Control-red application, if a window has been minimised an application icon will be displayed in the Wall
Control-red application bar. Place the cursor over the application icon and right click the mouse button. Select Input
Settings… from the list of options.
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Application Input Settings
 Select Input Settings with an Application window activated and the following dialogue is displayed.

 

 

When this dialogue is displayed, the application window is disabled preventing other users from modifying or closing it.

The dialogue displays the application currently selected and the command line arguments (if any) associated with the
application.
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On Screen Display
Selecting On Screen Display from the Window Menu will display an on screen display dialogue relevant to the type of window
currently active:

 
On Screen Display - Vision
On Screen Display - IP-Camera
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Accessing On Screen Display
There are various ways to access the On Screen Display (OSD) properties sheet, select from the following:

In the Wall Control-red application with, a window active, open the Window menu and select On Screen Display… from
the list of options.

In the displayed window, open the Window menu and select On Screen Display…

In the Wall Control-red application, place the cursor over the representation of the window and click the right mouse
button. Select On Screen Display… from the list of options.

Place the cursor over the active window on the desktop, click the right mouse button and select On Screen Display…
from the list of options.

In the Wall Control-red application, if a window has been minimized an application icon will be displayed in the Wall Control-red
application bar. Place the cursor over the application icon and right click the mouse button. Select On Screen Display… from
the list of options.
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IP-Camera On Screen Display Properties
 
 

 
The On Screen Display sheet allows you to configure the On Screen Display in the IP-Camera window. Any changes made to
the settings on the On Screen Display sheet take effect immediately. 

If an IP-Camera window is opened without a source connected, any text entered in the On Screen Display dialogue is not
displayed until a source has been connected.

Display Type

No on screen display

Disables the OSD function.

Simple Text

Select to insert the required text into the Simple Text edit box. When the Simple text option is selected, the Simple Text,
Background, Margins and Alignment groups are displayed on the OSD sheet.

From File

Select to display an OSD bitmap. When the From file option is selected the Background, Margins and Alignment groups are
displayed on the OSD sheet. Use the Browse button to select the bitmap image file (.bmp) from the file system of the Wall
Control-red Server.

Scaling

Fixed size

When Fixed size is selected, the OSD is displayed at the same size regardless of the size of the window.

Scale with window
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When Scale with window is selected, the OSD is scaled up or down according to the size of the window.

Simple Text

To enter text for the OSD simply type the required message in the Simple Text edit box.

Variables

The Variables function is a means of displaying a changeable value in the title bar.

Line wrapping

With Line wrapping switched on, if a line of text does not fit between the margins, line breaks are inserted between words to
produce shorter lines.

If Line wrapping is switched off, the text is displayed with the same spaces and line breaks as it has been entered.

Font

Select Font and the following dialogue is displayed:

 

 

Using the groups available, the characteristics of the font can be determined.

Background

Transparent

When Simple text is selected, the IP-Camera capture in the area behind the text is visible.

When From File is selected, the IP-Camera capture in the transparent colour parts of the bitmap image are visible. The
transparent colour is chosen by selecting Colour… to the colour dialogue.
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The colour dialogue contains a scaled down version of the selected bitmap image file and controls with which to select the
transparent colour. The colour can be selected by:

Clicking on a region within the scaled bitmap image.

Clicking on a colour from the basic colour palette.

Entering the hue, saturation and luma values into the HSL edit boxes.

Entering the red, green and blue values into the RGB edit boxes.

Opaque

When Simple text is selected, the area behind the text is displayed in a chosen colour. A range of colours are available by
selecting Colour…

When From File is selected the entire bitmap image is displayed.

Margins

The margins define the area in which OSD is displayed.

If Scale with window is selected, the margins are measured in pixels of the source. If Fixed size is selected, the margins are
measured in pixels of the interior of the IP-Camera window.

Any part of the OSD that falls outside the margins is not displayed.

Alignment

The alignment controls allow you to position the OSD within the margins.

Vertical

If you select Top, the top edge of the OSD will be displayed against the top margin.

If you select Centre, the centre of the OSD will be positioned half way between the top and bottom margins.

If you select Bottom, the bottom edge of the OSD will be displayed against the bottom margin.

Horizontal

If you select Left, the left edge of the OSD will be positioned against the left margin. For Simple Text each of the individual lines
will be left aligned.

If you select Centre, the centre of the OSD will be positioned half way between the left and right margins. For Simple Text each
of the individual lines will be centre justified.

If you select Right, the right edge of the OSD will be positioned against the right margin. For Simple Text each of the individual
lines will be right aligned.
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Vision On Screen Display Properties
Accessing Vision On Screen Display.
 

 
The On Screen Display sheet allows you to configure the On Screen Display in the Vision window. Any changes made to the
settings on the On Screen Display sheet take effect immediately. 

If a Vision window is opened without a source connected, any text entered in the On Screen Display dialogue is not displayed
until a source has been connected.

Display Type

No on screen display

Disables the OSD function.

Simple Text

Select to insert the required text into the Simple Text edit box. When the Simple text option is selected, the Simple Text,
Background, Margins and Alignment groups are displayed on the OSD sheet.

From File

Select to display an OSD bitmap. When the From file option is selected the Background, Margins and Alignment groups are
displayed on the OSD sheet. Use the Browse button to select the bitmap image file (.bmp) from the file system of the Wall
Control-red Server.

Scaling

Fixed size

When Fixed size is selected, the OSD is displayed at the same size regardless of the size of the window.

Scale with window
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When Scale with window is selected, the OSD is scaled up or down according to the size of the window.

Simple Text

To enter text for the OSD simply type the required message in the Simple Text edit box.

Variables

The Variables function is a means of displaying a changeable value in the title bar.

Line wrapping

With Line wrapping switched on, if a line of text does not fit between the margins, line breaks are inserted between words to
produce shorter lines.

If Line wrapping is switched off, the text is displayed with the same spaces and line breaks as it has been entered.

Font

Select Font and the following dialogue is displayed:

 

 

Using the groups available, the characteristics of the font can be determined.

Background

Transparent

When Simple text is selected, the Vision capture in the area behind the text is visible.

When From File is selected, the Vision capture in the transparent colour parts of the bitmap image are visible. The transparent
colour is chosen by selecting Colour… to the colour dialogue.
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The colour dialogue contains a scaled down version of the selected bitmap image file and controls with which to select the
transparent colour. The colour can be selected by:

Clicking on a region within the scaled bitmap image.

Clicking on a colour from the basic colour palette.

Entering the hue, saturation and luma values into the HSL edit boxes.

Entering the red, green and blue values into the RGB edit boxes.

Opaque

When Simple text is selected, the area behind the text is displayed in a chosen colour. A range of colours are available by
selecting Colour…

When From File is selected the entire bitmap image is displayed.

Margins

The margins define the area in which OSD is displayed.

If Scale with window is selected, the margins are measured in pixels of the source. If Fixed size is selected, the margins are
measured in pixels of the interior of the Vision window.

Any part of the OSD that falls outside the margins is not displayed.

Alignment

The alignment controls allow you to position the OSD within the margins.

Vertical

If you select Top, the top edge of the OSD will be displayed against the top margin.

If you select Centre, the centre of the OSD will be positioned half way between the top and bottom margins.

If you select Bottom, the bottom edge of the OSD will be displayed against the bottom margin.

Horizontal

If you select Left, the left edge of the OSD will be positioned against the left margin. For Simple Text each of the individual lines
will be left aligned.

If you select Centre, the centre of the OSD will be positioned half way between the left and right margins. For Simple Text each
of the individual lines will be centre justified.

If you select Right, the right edge of the OSD will be positioned against the right margin. For Simple Text each of the individual
lines will be right aligned.
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Accessing Split into Sub-Windows
There are various ways to access the Split into Sub Windows page, select from the following:

In the Wall Control-red application, with a Vision window active, open the Window menu and select Split into Sub-
Windows.

In the displayed Vision window, open the Window menu and select Split into Sub-Windows

In the Wall Control-red application, place the cursor over the representation of the Vision window and click the right
mouse button. Select Split into Sub-Windows from the list of options.

Place the cursor over the active Vision window on the desktop, click the right mouse button and select Split into Sub-
Windows from the list of options.
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Split into Sub-Windows
Accessing the Split into Sub-Windows dialogue
 
The Split into Sub-Windows function only applies to Vision windows.
 
Select Split into Sub-Windows and the following dialogue is displayed:

 

 

The Split into Sub-Windows dialogue is used to divide an active Vision window into sub-windows. Each sub-window will display
a cropped portion of the image that was shown in the original window. The sub-windows will all be the same size and will
occupy the same total screen size and position as the window that is being split. Once a window has been split the sub-
windows will replace the original window and the split operation cannot be undone.

Cropping restrictions may result in pixel loss for certain input resolutions and split topologies.

The Split into Sub-Windows dialogue has the following groups:

Sub-Window Topology

Split Windows

Split Window Options

Preview

Sub-Window Topology

The Sub-Windows topology group allows you to select the number of sub-windows that will be created when the window is
split. The number of sub-windows can be between two and sixteen. However, the maximum number of split-windows may be
limited by the size of the window being split. The minimum sub-window size is 160x120 pixels. Therefore, in order to split a
window into sixteen sub-windows then the size of the window being split must be at least 640x480 pixels. Use the horizontal
and vertical window edit boxes to select the desired sub-window topology.

Split Windows

The Split Windows group allows you to select the caption names and preset filenames for the sub-windows. The preset
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filenames are used to save each sub-window as an individual template called a preset. These presets can subsequently be
used in Wall Control-red to create an instance of the sub-window.

Window Number

The Window number drop down list allows you to select a specific sub-window. The Caption and Preset filename edit boxes
may then be used to set the desired caption and filename for the respective sub-window. When All is selected then any
changes to the Caption and Preset filename edit boxes will be applied to all of the sub-windows.

Caption

The Caption edit box is used to change the name in the title bar of the selected Vision sub-window(s).

Preset filenames

The Preset filename edit box allows you to select the filename (without suffix) that will be used to save the preset for the
specific sub-window selected in Window number. The preset filenames must be unique with respect to each other. If the input
variable is inserted into the Preset filename for a specific sub-window then it will be substituted with the name of the input itself
before the preset is saved.

The Preset filename edit box will only be enabled if the Save as preset-windows checkbox is selected.

Split Window Options

The Split Window Options allow you to select whether existing Vision windows are closed or saved as presets when the
window has been split.

Close existing input windows

If selected, other displayed Vision windows from the same input will automatically close when the window is split. Vision
windows from other inputs are not affected.

By default, Close existing input windows is not selected.

Save as preset-windows

If selected then the sub-windows will be saved as Wall Control-red preset files when the window is split.

By default, Save as preset-window is selected.

Once all options have been selected, click OK to split into sub-windows.

Preview

The preview frame displays an image showing how the window will look after it is split into sub-windows.
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Carousel Settings
Selecting Carousel Settings from the Windows menu will display the Carousel Settings dialogue relevant to the type of window
currently active:
 
 
Vision Carousel Settings

IP-Camera Carousel Settings
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Accessing Carousel
There are various ways to access the Carousel Properties page, select from the following:

In the Wall Control-red application, with the application window active, open the Window menu and select Carousel
Properties from the list of options.

In the Wall Control-red application, place the cursor over the representation of the Application Window and click the right
mouse button. Select Carousel Properties from the list of options.

In the Wall Control-red application, if a window has been minimised an application icon will be displayed in the Wall
Control-red application bar. Place the cursor over the application icon and right click the mouse button. Select Carousel
Properties from the list of options.
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Vision Carousel Settings
The Carousel Settings sheet allows you to define a number of inputs which the window will cycle through allowing you to view
each in turn. The inputs to be used are defined by creating a Display List. Each entry in the list can be viewed for a specified
duration and with different cropping rectangle. Once a Carousel Display List has been created, starting the Carousel causes
the Vision window to automatically cycle through the list of inputs.

To configure the Carousel properties for a Vision window, right click on the active window and select Carousel Properties and
the following dialogue is displayed:

 

 
 
When the Carousel Settings dialogue is displayed, the Vision window is disabled, preventing other users from modifying or
closing it.

The Carousel Settings dialogue has the following groups:

Input Selection

Cropping

Carousel Display List

Input Selection

Using the Input drop down menu, select the required input source. Its display time may be adjusted in one second intervals
using the Duration time control. The minimum display time is one second and the maximum is one day. The default setting is
one minute.

Cropping

The cropping controls allow you to select a rectangular region from the input signal to be displayed in the OEM_VISION_TAG
window. The Top and Left controls specify the position of the cropping rectangle relative to the top-left corner of the input
signal. The Width and Height controls specify the size of the cropping rectangle. The On radio button must be selected for
these values to be implemented. Selecting Off will ignore the cropping rectangle and display the raw input signal.

If the source is VGA, the Overscan radio button can be selected. Overscan automatically configures the best cropping values
for displaying the full input signal.
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for displaying the full input signal.

Carousel Display List

When the input, duration and cropping have been selected, click Insert to place the input on the Carousel Display List. The list
displays the input label, the duration of the display and the cropping details.

To remove an input from the display list, select the input and click on Remove. To change the display parameters, for example
increase the duration, select the input from the list and amend the duration to the required time. Once changes to the input
have been made click on Update to update the list.

Note: Modifying an input will not affect the Display List until the Update button has been clicked.

When the list of displays has been compiled the order in which they are displayed can be changed by selecting an input and
using the up/down arrows to alter its position within the list.  

By default, each input will be displayed for the specified duration regardless of whether a signal is present. To exclude
disconnected inputs from being displayed in the Vision window, select Skip disconnected inputs checkbox. This will cause
the carousel to automatically advance to the next valid input.

When the Carousel list has been defined, click Start to commence the display sequence.

Whilst the Carousel is active, the Carousel Properties dialogue will become disabled and the Start button will change to Stop.
To stop the carousel from running, click Stop and the dialogue will be re-enabled.

Note, when the Carousel is active, both the Carousel and Input Properties dialogues are disabled.

Saving Carousel settings in a Layout or Preset file

The 'Save Layout' and 'Save Preset' operations will store any defined Carousel settings , including the start/stop status to file.
When loading a layout or preset file containing a window with a Carousel input list, the window will automatically switch to the
first input in the list and then start or stop the Carousel according to its status at the time the file was saved.
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IP-Camera Carousel Settings
The Carousel Settings sheet allows you to define a number of inputs which the window will cycle through allowing you to view
each in turn. The inputs to be used are defined by creating a Display List, each entry in the list can be viewed for a specified
duration. Once a Carousel Display List has been created, starting the Carousel causes the IP-Camera window to automatically
cycle through the list of inputs.

To configure the Carousel properties for a IP-Camera window, right click on the active window and select Carousel Properties
and the following dialogue is displayed:

 

When the Carousel Settings dialogue is displayed, the IP-Camera window is disabled, preventing other users from modifying or
closing it.

The Carousel Settings dialogue has the following groups:

Input Selection

Carousel Display List

Input Selection

Using the Input drop down menu, select the required input source. Its display time may be adjusted in one second intervals
using the Duration time control. The minimum display time is one second and the maximum is one day. The default setting is
one minute.

Carousel Display List

When the input and duration have been selected, click Insert to place the input on the Carousel Display List. The list displays
the input label, the duration of the display.

To remove an input from the display list, select the input and click on Remove. To change the display parameters, for example
increase the duration, select the input from the list and amend the duration to the required time. Once changes to the input
have been made click on Update to update the list.

Note: Modifying an input will not affect the Display List until the Update button has been clicked.

When the list of displays has been compiled the order in which they are displayed can be changed by selecting an input and
using the up/down arrows to alter its position within the list.  
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using the up/down arrows to alter its position within the list.  

When the Carousel list has been defined, click Start to commence the display sequence.

Whilst the Carousel is active, the Carousel Properties dialogue will become disabled and the Start button will change to Stop.
To stop the carousel from running, click Stop and the dialogue will be re-enabled.

Note, when the Carousel is active, both the Carousel and Input Properties dialogues are disabled.

Saving Carousel settings in a Layout file

The Save Layout operation will store any defined Carousel settings , including the start/stop status to file. When loading a
layout file containing a window with a Carousel input list, the window will automatically switch to the first input in the list and then
start or stop the Carousel according to its status at the time the file was saved.
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Accessing Audio Settings
There are various ways to access the Audio Settings page, select from the following:

In the Wall Control-red application, with a Vision window active, open the Window menu and select Audio Settings.

In the displayed Vision window, open the Window menu and select Audio Settings

In the Wall Control-red application, place the cursor over the representation of the Vision window and click the right
mouse button. Select Audio Settings from the list of options.

Place the cursor over the active Vision window on the desktop, click the right mouse button and select Audio Settings
from the list of options.
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Audio Settings
The Audio Settings dialogue allows you to control the audio sources associated with a specific Visionwindow. All the controls
within the dialogue are interactive; therefore any changes made are shown when the next frame is displayed in the window.

There are two groups of Audio dialogue in the Vision application; analogue and digital. If line out is not available, the line out
control will not appear. If no audio input is available, the audio settings group will be disabled and unavailable; all other controls
will be removed from the dialogue.

Analogue Dialogue

 
 

Digital Dialogue
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Audio Settings

Enable audio for current window

When Enable audio for current window selected is checked, an audio stream for the active window will open. An indication
of the stream will appear in the Windows Mixer which is available in the Windows Operating System taskbar (small speaker
icon). When disabled, the stream will be closed and removed from the Windows Mixer.

Mute window when not active

When Mute window when not active is checked, the application applies a software mute to any audio stream where the
window is not active. The audio stream will still be active and will still appear in the Windows Mixer.

Reset

The Reset button will reset the hardware to its default settings. As this is a hardware device, setting it will apply to all windows
sharing audio on the input.

Sample Rate

The Sample Rate box displays the sample rate currently selected by the Windows Mixer. This can be changed using the
Advanced Properties tab in the Windows Mixer settings. To access the Advanced Properties, right click on the speaker icon on
the right of the Windows taskbar, select Playback devices, right click on Speakers and select Properties.

Channel Left / Right

This is a visual display of the audio levels for the current window.

Line Out

Mute

Select to mute the line out in hardware.

Gain

Use the slide bar to control the gain applied by the hardware. Units are measured in dB.

Source

The Source determines whether the line out is from the digital or analogue input on the card.

Line out is only available to the user when an audio module device is fitted via a ribbon cable to the Vision capture card. The line
out source for multiple input streamed devices is restricted to a maximum of two sources. The first output is analogue audio,
available via the attached audio module, the second output is the first available digital device physically sharing the composite
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available via the attached audio module, the second output is the first available digital device physically sharing the composite
video device bridge on the PCIe bus.

Analogue

Unbalanced Input

Mute Input

Select Mute Input to mute the selected input in hardware.

Gain

Use the slide bar to control the gain applied by the hardware. Units are measured in dB.

Balanced Input

Select Mute Input to mute the selected input in hardware.

Boost 20dB

Selecting Boost 20dB will boost the gain applied to the balanced input by 20dB.

Gain

Use the slide bar to control the gain applied by the hardware. Units are measured in dB.

Output Mixer

Mute Input

Select Mute Input to mute the selected input in hardware. 

Gain

Use the slide bar to control the gain applied by the hardware. Units are measured in dB.

Digital

Mute Input

Select Mute Input to mute the selected input in hardware.

Stereo Pair

The drop down menu allows the user to select a digital channel stereo pair (left/right) available on the source, for example a
language selection.
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Tool Menu
The tools menu displays a list of available tools to use in conjunction with Wall Control-red.
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Configure Menu
The configure menu allows you to configure the types of window to be displayed.

Wall Control-red

Screen Order

Screen Labels

Server Applications

Remote Command Line

Application

Vision

IP-Camera
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Wall Control-red
Select Wall Control-red from the Configure menu and the following dialogue is displayed:

 

 

 

Wall Control-red Application Window

Always on top

If selected, this option forces the Wall Control-red application window on top of all other application windows.

Save Layout Dialogue

The Save Layout Dialogue enables you to configure whether the layout file is saved when exiting the Wall Control-red
application, disconnecting from the Wall Control-red server or opening another layout file.

Select Show dialogue to display the prompt asking if any changes are to be saved.

Select Always save layout to save the changes to the currently open layout file. If the layout has not previously been saved, i.e.
it is a new layout then the Save As dialogue will be displayed.

Select Never save layout to discard any changes which may have been made to the layout file since it was opened.
 

Disconnect Dialogue

The Disconnect Dialogue enables you to configure what happens to the Windows that manages when exiting the Wall
Control-red application or disconnecting from a Wall Control-red server.
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Select Show dialogue to display the Disconnect dialogue.

Select Always close windows to close all windows that Wall Control-red manages.

Select Never close windows to leave open all windows that Wall Control-red manages.

Display of Video/Data Wall

The Wall Control-red application can be configured to display a capture of the desktop within the application window.

Select Wire frame to display a wire frame representation in the Wall Control-red application window.

Select Capture desktop and the desktop is displayed in the Wall Control-red application window. The captured desktop is
refreshed approximately every second. Capturing the desktop will use up more system resources than the wire frame display.

Show gaps enables you to display any desktop gaps you have created on the captured desktop. This function is only available
when Capture desktop is selected.

Display of Control Screen

A non-Datapath graphics card such as an on board graphics adapter can be used as a Control Screen for the Wall Control-red
application. If this method is used a representation of the Control Screen is displayed in the Wall Control-red application.

Display of Control Screen enables you to configure how the control screen is displayed in the Wall Control-red application
window.

Select Don’t show and the Control Screen representation is removed from the Wall Control-red application window.

Select Wire frame to display a wire frame representation in the Wall Control-red application window.

Select Capture desktop and the desktop of the Control Screen is captured and displayed in the Wall Control-red application
window.

Alerts - Wire Frame Only

If it is not possible to display a Vision input, the area where the window is displayed in Wall Control-red can be made to flash.

The reasons why a source cannot be displayed fall into two categories: no signal and error.

If no signal is detected the source has been disconnected or switched off.

If an error has occurred, one of the following has happened:

The signal is beyond the capabilities of the hardware.

There are no hardware resources available to display the signal.

An error has occurred within the system.

You can switch the flashing of the windows on or off and change the text that appears when the input cannot be displayed.

Language Select

Use the dropdown arrow to select the required display language.
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Screen Order
Select Screen Order from the Configure menu and the following dialogue is displayed:

 

 

The dialogue is used to set the order in which the screens appear on the desktop. When first opened, the dialogue displays the
current screen order.

The screen order is set by clicking the screens in the representation. The sequence in which the screens are selected defines
what the screen order will be. When the screen is clicked, it will be shaded and a number will be allocated to the screen
indicating its position in the sequence.

 

 

If an error is made while entering the sequence, click on Cancel and start again.

When the screen order has been entered, click on OK. To reject the new selection click on Cancel.

Note: The new screen order will not be applied until the Wall Control-red server is re-booted.

 

105 / 155



Screen Labels
Select Screen Labels from the Configure menu and the following dialogue is displayed:

 

 

The Screen Labels dialogue enables you to display labels on each the screen within the Wall Control-red application window.

To label the screens, click inside the label edit box in the screen representation on the left of the Screen Labels dialogue and
type in the desired label. Once the labels have been entered, click on OK.

Visibility

Once your screen labels have been created you can use the Visibility control to show or hide the labels in the Wall Control-red
application.

Alignment

Use the Alignment control to position the Screen Labels within the Wall Control-red application; any changes to the alignment
settings will affect the position of all the labels.

Background

The Screen Labels are created as black text on a white background. The Background control enables you to choose to
display the white background or not.

To display the white background select Opaque, to remove the white background select Transparent.

Layering

The layering control allows you to set the labels to display behind or in front of the window representations in the Wall Control-
red application.
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Server Applications
Selecting Server Applications displays the following dialogue:

 

 

The Server Application Manager shows the status of each of the server applications installed on the Wall Control-red server
and allows them to be started, stopped and configured.

The Status column indicates the status of each of the server applications:

Running indicates that the server application is running correctly. To stop the server application click on the Stop button.

Stopped indicates that the server application is not running. To start the server application click on the Start button. If the
server application fails to start, you will need to look in the application Event Viewer.

Error indicates that the server application is running but that it encountered a problem that will prevent it from functioning
correctly. Click on the Details button to see a message describing the problem. You should correct the problem and start the
server application again.

 

 

Port Number

The Port number describes the communication channel between the local and remote machines.

A port conflict will occur if another application is using the same Port number.

Port Name

The Port name describes the communication channel used when the application and server are on the same machine.

Once the Port number or Port name has been configured, click OK to continue. The server application will need to be stopped
and started again for the changes to take effect.

 

 

107 / 155



Vision
 
When Vision is selected, the following dialogue is displayed.

Use the Configure Vision dialogue to set up the labels for the Vision inputs.
 

 

 
Click on Add… to create a new label and the following dialogue is displayed:
 

Input Labels

 
Click Addto create a new label and the following dialogue is displayed:
 

 
Type the label in the Label edit box. The label can be up to 31 characters long with no leading or trailing spaces. Only one label
can be created for each Vision input.

Use the up / down arrows to select an input.

Click on OK and the label will be added to the list of Input Labels in the Configure Vision dialogue box.

The label will also be displayed in the list of available Vision Sources on the Input Settings sheet.

Window Text

Use the Window Text controls to amend the text display in a Vision window when 'No Signal' or 'Invalid Signal' is detected on
the input.
 

EDID
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Use the EDID (Extended Display Identification Data) controls to edit the preferred modes of the EDID contained on the Vision
input. An EDID is a data structure provided by the Vision capture card input to describe its capabilities to a video source (e.g.
graphics card or set-top box).
 
Note:
 
Inputs that contain only a configurable EDID appear in the input drop down list. For example, standard definition
EDID's are not configurable. After selecting the appropriate input, use any of the following options:

 

Configure

Select Configure... to display the following Preferred Timings dialogue for Vision inputs capable of advertising an EDID:
 

 
The Preferred Timings dialogue displays the resolution of the current mode for reference and allows the timings of the EDID
preferred mode 1 and 2 to be edited. The dialogue supports standard timing formulae such as: VESA, CVT, CVT Reduced
Blanking, SMPTE (for HD modes), VESA, GTF and Custom. Selecting Auto from the drop down list will typically default to the
VESA CVT algorithm which best matches typical standard VESA output modes. However, to minimise dot clocks and hence
maximize DVI cable lengths, the CVT Reduced Blanking is recommended.

Selecting Custom from the drop down menu allows the timing parameters to be edited.

Note: You will need to select between definition of Pixel Clock or Vertical Refresh since these are mutually exclusive
parameters.

Once edited, clicking OK writes the preferred mode into the input EDID but may not normally affect the input mode that is being
captured. It may be necessary to force the graphics device in the host machine to detect the new modes, this can be done by
selecting Detect on the display devices Screen Resolutions dialogue or rebooting the display device.

Reset

Use the Reset button to restore the default EDID supplied when the card was purchased.

Import
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Use the Import button to import only the preferred timings from an existing EDID binary file.

Note: Only the first two preferred blocks in the EDID will be imported.

Export

Use the Export button to export the complete EDID binary file advertised on the Vision input.
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Remote Command Line
The Remote Command Line dialogue allows you to monitor and control the remote command line interface server components
in Wall Control.

The remote server components operate independently from the Wall Control application itself. Once you have configured and
enabled the active server using the Remote Command Line dialogue then it will continue to monitor and execute commands
after Wall Control is closed. Once enabled, the active server will automatically start each time the machine is booted.

Select Remote Command Line from the Configure menu and the following dialogue is displayed:

 

Status

The control indicates the current status of the active server. While the Enabled checkbox is un-checked then the status will
show Disconnected. When checked the status will indicate a message that is specific to the selected active server.

Status messages for COM Port Command Line Interpreter

When connected, the COM Port Command Line Interpreter displays the status Connected. Any other status message will
indicate a connection error (see troubleshooting section for further details).

Status messages for Telnet Command Line Interpreter

When enabled, the status will display Waiting for connections. Once a client has connected then the status will initially
change to Waiting for client authorization. The status Client authorized will be shown once either the client has sent the
correct password or if no password is configured.

Monitor

The Monitor control displays each character as it is received by the active server. Each complete command is shown on a
separate line. If a command failed to execute then an appropriate error message is displayed on the line below. The monitor
control also shows any server specific status and error messages as commands are received and processed.

Enabled

This checkbox will allow you to enable or disable the currently selected active server. Any changes made will take effect when
either the OK or Apply buttons are pressed.

Active Server

The Active Server drop down list shows the currently selected remote server. Only one of the servers in this list can be active at
a time. When the active server is changed then the new server is initially set to the disabled state.

The two servers that can be selected are the COM Port Command Line Interpreter and the Telnet Command Line Interpreter
which are described below.

COM Port Command Line Interpreter
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The COM Port Command Line Interpreter server monitors a serial port connection in order to receive and execute commands
sent from a remote device (eg. a Crestron/AMX controller). The transmitted characters sent over the serial connection are
cached into a buffer until the carriage return or line feed character is received. At this point the current command in the buffer is
executed. The configuration details for the serial connection can be modified using the Settings button once the COM Port
Command Line Interpreter has been selected as the active server.

Telnet Command Line Interpreter

The Telnet Command Line Interpreter server monitors a network port for connections made using the Telnet protocol. The
server allows remote clients to transmit strings of characters that will be buffered and executed as a command on the server
machine. The current command is executed when the client sends a carriage return character followed by a line feed
character. The Telnet Command Line Interpreter server only accepts connections from a single client at a time. The
configuration details for the Telnet connection can be modified using the Settings button once the Telnet Command Line
Interpreter has been selected as the active server.

Settings

The settings button opens the settings dialogue for the currently selected active server. If any changes are made to the settings
then the active server will be restarted when the OK button is pressed. If the Cancel button is pressed then no changes will be
made to the settings.

Settings dialogue - COM Port Command Line Interpreter
 

The COM Port Command Line Interpreter Settings dialogue allows you to configure the serial port connection in order to match
the configuration of the device with which you are communicating.

Port

The Port control allows you to select the serial port that is to be used for the serial connection. While all possible 255 ports are
listed, not all of these ports may be installed or available on the machine.

Baud Rate

The Baud Rate control allows you to select the maximum rate at which the data is transmitted through the serial port
connection (in bits per second).
 

Data Bits

The Data Bits control allows you to specify the number of bits in each character that is transmitted and received. It is
recommended that this should be set to the value '8'.

Stop Bits

The Stop Bits control allows you to specify the number of bits in each character that will be used by the receiving device to
detect the end of a character and to resynchronize the stream. It is recommended that this value is set to 1.

Parity

The Parity control allows you to change the type of error checking that is used. It is recommended that this value is set to
'None'.

Flow Control

The three Flow Control text boxes DTR/DSR, RTS/CTS and XON/XOFF are used to change how the flow of data is controlled.
It is recommended that only the XON/XOFF checkbox is enabled.

Report process return values

This control allows the value returned by the operating system when an executable is launched to be written back to the serial
port when the process terminates. This value is preceded by the original command itself.
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port when the process terminates. This value is preceded by the original command itself.

Settings dialogue Telnet Command Line Interpreter

 

The Telnet Command Line Interpreter Settings dialogue allows you to configure the network port and configuration settings for
the server.

Port

The port control allows the network port that the Telnet Command Line Interpreter server listens on to be changed. It is
recommended that care should be taken to ensure that the selected port does not clash with a port used by another program
on the system. The default telnet port is 23.

Password

The password control allows a password of up to 23 characters to be set. This password must be sent by a client to authorise
the connection before any commands can be executed. The client must send the password to the server as a string in the
same manner as a normal command. A carriage return character followed by a line-feed character is sent to mark the end of
the password. If a client does not send the correct password within 10 attempts then the Telnet Command Line Interpreter is
automatically disabled. When the 'Hide' checkbox is enabled then all password characters are substituted with a * character.

Options

If the 'Echo' checkbox is enabled then each character sent by a client will be transmitted back to the client after it is received by
the server. If the character is sent during password authentication then it will be substituted for a ‘*’ character.

If the Acknowledge checkbox is enabled then the server will send a carriage return character followed by a line feed character
back to the client after each command has been executed. This allows clients to transmit commands and then wait for the
acknowledgement before closing the telnet connection. This is especially useful for clients that only send single commands at
a time.
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IP-Camera Configuration
When IP-Camera is selected the following dialogue is displayed. If the system has no Render Stations previously configured,
the dialogue will open on the Configure Render Stations tab.

One or more Render Stations must be successfully configured before any IP-Camera windows can be opened. The outputs
from Render Stations are captured using VisionRGB-E2 inputs. You must ensure that there are enough VisionRGB-E2 inputs
available in your system for the number of licensed Render Stations.

 

To configure a Render Station, click on Add... and the following dialogue is displayed:
 

 
Using the Vision Input drop down menu select an input to allocate as the input channel. This channel will be removed from the
list of available Vision sources in the Wall Control-red application toolbar.
 
The Render Station will output two screens, A and B. Select the screen you wish to allocate to the selected Vision input.
 
Insert the IP Address / Host Name into the edit box and click on OK.
 
The Render Station configuration dialogue will now display details of the configured Render Station. Continue to add more
Render Stations as required.
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Render Stations as required.
 
When the Render Stations are configured and OK is pressed on the Configure dialogue, Wall Control-red will connect to the
Render Stations. When the Render Stations are connected Vision inputs assigned to Render Stations will become unavailable
to the Vision application.
 
A configured Render Station screen can be deleted by selecting its entry from the list in the Configure dialogue and pressing
the Remove button. To completely remove a Render Station both Screen A and Screen B must be removed.
 
The IP Address of a Render Station assigned to a VisionRGB-E2 input can be changed by selecting the entry from the list and
clicking the Modify button. The VisionRGB-E2 input cannot be changed from the Modify dialogue, and a new entry must be
created instead.
 

Render Station Status

 
The status column indicates the connection status for each configured Render Station screen. The five possible states are as
follows:

Testing

Wall Control is in the process of testing all connections.

Offline

The Render Station has not been connected. All stations are shown as offline until they can be connected. It may take up to
twenty seconds for the status to change to the connected state.

Flash Error

The Render Station was successfully connected but the Vision card's EDID could not be flashed. This may be caused by a
hardware issue or the use of an incorrect driver. When in this state the capabilities may be reduced.

Screen Error

The Render Station was successfully connected but an initialisation error occurred. This may be caused by an incorrect
software or hardware configuration on the Render Station. When in this state the capabilities may be reduced.

Connected
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The Render Station was successfully connected and is ready for use.

Error

The Render Station was previously connected without any errors but is now not responding. It will revert to a connected state
once the connection is restored.

Reboot

The Reboot button allows the user to remotely reboot a connected Render Station. It can also be used to reset the connection
to a station that is in an error state. This is intended as an administrative tool and should only be used under the direction of
support staff.

Configuring Cameras

By default Wall Control-red does not have any cameras configured. The user may add cameras by clicking the Add button on
the right side of the dialogue.

 

 

 

Adding New IP-Cameras

Click on the Add button and the following dialogue is displayed.
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Camera Name

Type the camera name into the Camera Name edit box. The name can be up to 31 characters long with no leading or trailing
spaces and must be unique with respect to all other camera names.

Camera Model

Use the camera model drop down list to select the model of the camera that is being configured. This list will contain a number
of pre-configured models along with any additional user configured models that have been added to the system.

Camera Authorisation

Use the camera authorisation controls to override the camera model’s default settings.

IP Address / Host Name

Use the IP address or host name edit box to set the camera’s network address. This field may also contain a port number
separated by the ‘:’ character (ex. 10.0.0.2:7071). If this edit box is left blank then a warning prompt will be displayed when the
OK button is pressed.

Once the camera configuration is complete press the OK button to create the camera and close the dialogue.

Note:

IP-Camera connectivity is not validated at the point at which a camera is configured. Therefore, the successful
configuration of a camera does not guarantee that the camera in question will operate as expected in Wall Control-
red.

 

 

Modifying and Removing Existing IP-Cameras
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IP-Cameras can be modified by selecting the camera name and then clicking on the Modify button.

IP-Cameras can be removed by selecting the camera name and then clicking on the Remove button.

Test Button

To test a camera, click on Test and the following dialogue is displayed:
 

 
Use the Render Station drop down list to select a station on which to test the camera. The Render Station are listed with the
connected stations at the top. Click the Test button to initiate the test. Once the test has been completed, the results are
displayed in a message box. The most common test results are as follows:
 

Camera Operational

The Render Station successfully established a connection to the camera's RTSP port.

Camera Unreachable

The Render Station did not get a reply when an attempt was made to establish a connection to the camera's RTSP port. This
may be due to an invalid camera configuration or a network issue.

Camera Connection Refused

The Render Station was refused a connection to the camera's RTSP port, this may be due to an invalid port.

Render Station Comms Error
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The selected Render Station is offline.
 

Configure Camera Models

By default Wall Control-red supports a number of pre-configured IP-Cameras. The Camera Models configuration dialogue
allows additional camera models to be defined that should work with other IP-Cameras, including those from different
manufacturers.

The Camera Models tab has three buttons located to the right of the model names. The status and names of these buttons will
change depending on which, if any, of the models are selected and also on the current Wall Control-red license. Camera
Models can be added providing a red dongle is inserted into the machine. The middle button is entitled “View” when one of the
pre-configured models is selected. These models are read only and cannot be modified or removed. However, when a model is
selected that has been added to Wall Control-red (via the add button) then this middle button is entitled “Modify”. This button
can then be selected to make changes to the model in question.

 

 
Click on the Add or Modify/View buttons to display the IP-Camera Model dialogue (shown below). The controls in this dialogue
are read only if a pre-configured model is being modified.
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Model Name

Type the model name into the Model Name edit box. The name can be up to 31 characters long with no leading or trailing
spaces and must be unique with respect to the names of all other camera models.

Login Credentials

The Login Credentials edit boxes can be used to set a default user name and password for the camera model. These
credentials will automatically be set for any cameras that are subsequently configured for this camera model (although they
can be overridden for individual cameras if necessary).

Path

Use the path edit box to enter any model specific path information that Wall Control-red must combine with the IP address or
host name in order to access the IP-Camera’s stream. This information can typically be found in the IP-Camera’s
documentation or by contacting the manufacturer. If the IP-Camera is part of an existing security system then this information
may be extracted from the URLs currently being used.

The purpose of this path control is to save the user from having to type in the full URL for every camera of the same model.
Please take care to ensure that only the Path is entered into this edit box and not the IP address or host name. For example if
the full URL was “rtsp://10.0.0.2/Mediainput/mpeg4” then the path would be “Mediainput/mpeg4” or if the URL was
“rtsp:/axis.mynetwork.co.uk/mpeg4/1/media.amp” then the path would be “mpeg4/1/media.amp”.

 

Click the Remove button in the Camera Models tab to remove the selected camera model. Please note it is not possible to
remove pre-configured models. It is also not possible to remove a model associated with any open IP-Camera window. If an
attempt is made to remove a model used by one or more open windows then an error box is displayed and the operation will
fail.

When the Remove button is selected for a model in use by one or more cameras that have been added to Wall Control-red the
following dialogue is displayed. This dialogue will list the names of the cameras used by the model being removed. If the user
selects the Remove button then all of these cameras will be removed along with the camera model itself.
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Application
Select Application from the Configure menu and the following dialogue is displayed:

 

Application Group

The Application group displays a list of all supported applications, including those that may not be installed on the system. This
list contains both supported Applications that are pre-installed with Wall Control-red and also custom Applications that may
have been added by the user.

Checkbox

The checkbox for each application indicates if the application and its associated inputs are available in the Wall Control-red
toolbar. Only applications detected on the system are enabled.

Applications

The application name field shows the name of the application in question. If required, the user can change the name by double
clicking on the name. If a blank name is entered then the application name will be restored back to its default value.

Path

The application pathname displays the full path to the executable file associated with the application. The path is editable by
double clicking on it. If an empty string is entered into the application pathname it is restored to its default value. If an executable
file is entered that doesn't match the application, the application is disabled.

Command Line Switches

The command Line switches field shows any command line arguments, excluding any input file/URL that are required to launch
the application. These switches can be edited by the user.
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Add

The Add button allows a new custom application to be added to Wall Control-red. Click the Add button and the Add Application is
displayed. Enter a unique Application name and a valid path in order to add the new Application to the system. Note: custom
Applications have restricted functionality and in some cases may exhibit compatibility issues with Wall Control-red.

Modify

The settings for an application can be accessed by clicking the Modify button. This displays the Modify Applications dialogue in
which the Name, Path and Switches can be changed in order to override any default values for the application. These values
can also be restored back to their default values by pressing the 'Default' button. Only pre-installed supported applications can
be restored to their default values. For any applications that have been added by the user, the Default button will be greyed out.

Remove

The Remove button allows a custom application to be removed from the list. Only custom applications created using the Add
button can be removed. The Remove button is disabled if a non custom application is selected.

Inputs Group

The lower pane of the Application dialogue lists the inputs that have been configured for the selected application.

Name

The name field shows the user defined name for the application input.

Path

The path field shows the user defined path for the application input. This may consist of either a file path or a URL depending on
the application. This path string will be appended to the string from the application's 'Command Line Switches' field (if set)
when the input is opened from the Wall Control toolbar. The path string will also be used when an input is changed for the
application window that is already open (without the 'Command Line Switches' string). It is therefore important that the Path
string does not contain any command line switches (ex. -Input=). If switches are required then these should be entered
separately into the 'Command Line Switches' field described above.

Add

The Add button allows a new input to be added for the Application that is currently selected. When the Add button is clicked, the
Add Input dialogue is displayed. A unique input name and valid path name must be entered in order to add a new input to the
system.

Modify

The settings for an input can be accessed by clicking the modify button. This displays the Modify input dialogue in which the
Name and Path can be changed.

Remove

The remove button allows a selected input to be removed from the list.
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Help
The Help Menu provides information about how Wall Control-red works and how to use the application.

Contents

Selecting Contents opens the on-line help files displaying a contents tree containing all the help topics associated with
the Wall Control-red application.

About

Selecting the About… option will display a dialogue containing details of the version number of the Wall Control-red
application and the serial number of the red dongle which is inserted in the USB port. To upgrade the number of Render
Station licenses the dongle serial number will need to be provided.
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Vision Window File Menu - Save Image As
Select Save Image As… to save the frame displayed in the application window in one of the following formats:

.bmp

.jpeg

.gif

.tiff

.png

The image is cropped using the values specified in the Input Settings dialogue but it is not scaled.

Select Save Image As… and the following dialogue is displayed: The pixel format is the format specified in the Windows
Properties dialogue.

Select Save Image As… and the following dialogue is displayed:

 

 

Type in the required file name and browse to the folder of your choice then select Save.
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Vision Window File Menu - Pause/Run
Selecting Pause freezes the input source and displays the latest captured frame.

When Pause is selected from the File Menu the Vision application discards the current frame being captured, saves the next
frame to the computer's memory and no longer continues to capture the source.

The frame that has been captured and stored to memory is then displayed in the Vision application window.

To resume displaying the source, select File|Run and the source is once again displayed.
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Vision Window File Menu - Save As Preset-Window
Select Save As Preset-Window to save a particular window as a preset. All saved Preset-Windows are listed in the Wall
Control-red application toolbar.

Select Save As Preset-Window and the following dialogue is displayed:

 

Preset Filename

The Preset filename edit box allows you to select the filename (without suffix) to be used to save the selected Vision window as
a preset. Wall Control-red uses the filename when listing the preset in the application toolbar and in the preset option in the New
menu.
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Vision Window File Menu - Print
Selecting Print from the File menu displays the following print dialogue box:

 

 

Use the print dialogue box to choose the printer settings and click OK.

The captured frame will then be printed.

Note: 
As only one frame has been captured, the only option available in the Print Range Group will be All.
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Vision Window File Menu - Page Set Up
Select Page Setup from the File Menu and the following dialogue is displayed:

 

 

Use the Page Setup dialogue to select paper size, orientation, margin widths, centring the captured image and scaling.

Once all the required selections have been made, click OK.
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Window Menu - Window Properties
Window Properties
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Vision Window Menu - Input Settings
Input Settings
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Vision Window Menu - On Screen Display
On Screen Display
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Split into Sub-Windows
Split into Sub-Windows
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Audio Properties
Audio Properties
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Carousel Properties
Carousel Properties
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IP-Camera
The command line interface allows you to create, modify or close IP-Camera windows.

The command line interface can be accessed in a number of ways:

From a shortcut specifying IPCAMCMD.EXE as the target followed by the command line options separated by spaces.

From a command prompt by specifying the full path of IPCAMCMD.COM or by having the folder where the IP-Camera
software was installed on the path.

From a batch file. The same rules as command prompt apply.

Nomenclature
Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

-ID=number

When a window is created it can be allocated an ID. To modify or close a window, specify its ID so the correct window is
modified or closed.

An ID is any integer between 1 and 65535. The ID is specific to IP-Camera windows.

-Input=camera name

Specifies the name of a camera. This camera must already have been configured in Wall Control

-Close

If this command line option is specified with an ID, the window with that ID is closed.

-ShowState={Minimised|Restored|Maximised|Show|Hide}

Sets the show state of the window.

To activate a window use Restored.

-AlwaysOnTop={On|Off}

-AspectRatio=[{On|Off|],[width],[height]

Switch the maintain aspect ratio feature on or off and specify the ratio of the width and height of the window.

All the values are optional but the commas must be used.

-Caption=

Set the caption of the window. To include spaces, enclose the string in double quotes (").

-ShowFrameRate={On|Off}

Display or remove the current frame rate in the title bar,

-ShowMenuBar={On|Off}

Use to specify if the menu bar is to be displayed.

-Window=[top],[left],[width],[height]
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Change the position and size of the window.

All the values are optional but the commas must be used.

-WindowStyle={BorderAndTitleBar|BorderOnly|NoBorderOrTitleBar}

The following command line options allow changes to the appearance of the IP-Camera source. The numbers correspond to
the values displayed on the Input Settings sheet.

Networking Options

To control a window on a machine other than the one you are working on you will need some of the following options:

-Machine={machine name|IP address}

Use this option to specify the machine to connect to.

-Port=port number

You need to specify the port if you are attempting to control a window on another machine and the server has been configured
to listen on a port other than the default port 1049.

A port number is any integer between 1 and 65535.

If the server requires a User Name and Password, the following options should be used:

-UserName=user name

-Password=password

If the machine is not participating in a domain, the account must be on the machine you are connecting to.

If the machine is participating in a domain you have a choice:

The account can be on the machine you are connecting to.

It can be an account on the domain.

If the account is on the domain, the domain name must be specified with the following option:

-Domain=domain name
 

On Screen Display (OSD)

Click here for OSD Command Line Interface
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Wall Control-red
The Wall Control-red command line interface allows you to open layout files.

The command line interface can be accessed in a number of ways:

From a shortcut specifying wallctl.exe as the target followed by the command line options separated by spaces.

From a command prompt by specifying the full path of wallctl.exe or by having the folder where Wall Control-red was
installed on the path.

From a batch file. The same rules as command prompt apply.

From the COM Port Command Line Interpreter. The same rules as command prompt apply.

Example Usage

Open the Layout file "c:\layouts\layout.lay" and exit without showing the Wall Control-red application window.

"C:\Program Files (x86)\Wall Control\wallctl.exe" -Layout="c:\layouts\layout.lay" -exit
 

Connect to a computer named VideoWall and close all existing windows.

"C:\Program Files (x86)\Wall Control\wallctl.exe" -Machine=VideoWall -CloseWindows=Yes
 

Connect to a computer named VideoWall without showing the Wall Control-red application window and save the
configuration to a layout file named "c:\layouts\snapshot.lay".

"C:\Program Files (x86)\Wall Control\wallctl.exe" -Machine=VideoWall -Save="c:\layouts\snapshot.lay" -exit
 

Nomenclature

Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

Commands

-Layout=layout file

This command line argument specifies the layout file to be loaded.

If the layout file name or path contains spaces then enclose the path in quotes, for example:

-layout=”C:\Documents and Settings\user\Desktop\file.lay”

-layout is not compatible with -machine.

-Exit

When used with the -layout option, -Exit will cause the Wall Control-red application to load the layout file without the
application window being displayed and to terminate once the layout file has been loaded.

Use this option to open a layout file without displaying the Wall Control-red application.

When -Exit is specified on the command line, an exit code is returned.

-Quiet

Used in conjunction with -Exit to suppress user interface dialogue boxes.
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-CloseWindows={YeslNo}

Use -CloseWindows=Yes to close existing windows.

Use -CloseWindows=No to keep existing windows open.

When the -layout command line option is specified, the default value for -CloseWindows is Yes.

When the -machine command line option is specified, the default value for -CloseWindows is No.

-ShowState={Minimised|Restored|Maximised}

Controls the appearance of the Wall Control-red application window.

-Window=[top],[left],[width],[height]

This option enables the Wall Control-red application window to be positioned.

If a number is left out of the list then the value saved when the application was last terminated is used.

To change the position of the window without changing the size:

-window=100,200

To change the size of the window without changing the position:

-window=,,800,600

-AlwaysOnTop={TrueIFalse}

This sets the Always on Top state of the Wall Control-red application window.

To enable the window to behave normally, the value should be set to false.

To force the window to be displayed on top of all other normal windows the value should be set to true.

1 or on can be substituted for true.

0 (zero) or off can be substituted for false.

-Save= Layout file

Allows the saving of a layout file from the command line. It’s not compatible with the –layout or –closewindows options
but can be used with –exit

Networking Options

To control a machine other than the one you are working on you will need some of the following options:

-Machine={machine name|IP address}

This option specifies the machine to connect to.

If the machine name contains spaces then enclose the name in quotes, for example:

-machine="My Computer"

You can also specify an IP address, for example:

-machine=10.0.0.21

-machine is not compatible with -layout.

If the server requires a User Name and Password the following options should be used:

-UserName=user name

-Password=password

If the machine is not participating in a domain, the account must be on the machine you are connecting to.

If the machine is participating in a domain, you have a choice:

The account can be on the machine you are connecting to.

It can be an account on the domain.

 

138 / 155



If the account is on the domain, the domain name must be specified with the following option:

-Domain=domain name

-Port=port number

You need specify the port if you are attempting to connect to another machine and Wall Control-red has been configured to
listen on a port other than the default port.

A port number is any integer between 1 and 65535.
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Vision
The command line interface allows you to create, modify or close Vision windows.

The command line interface can be accessed in a number of ways:

From a shortcut specifying RGBXCMD.EXE as the target followed by the command line options separated by spaces.

From a command prompt by specifying the full path of RGBXCMD.COM or by having the folder where the Vision
software was installed on the path.

From a batch file. The same rules as command prompt apply.

Nomenclature
Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

-ID=number

When a window is created it can be allocated an ID. To modify or close a window, specify its ID so the correct window is
modified or closed.

An ID is any integer between 1 and 65535. The ID is specific to Vision windows.

-Close

If this command line option is specified with an ID, the window with that ID is closed.

-ShowState={Minimised|Restored|Maximised|Show|Hide}

Sets the show state of the window.

To activate a window use Restored.

-AlwaysOnTop={On|Off}

-AspectRatio=[{On|Off|Source}],[width],[height]

Switch the maintain aspect ratio feature on or off and specify the ratio of the width and height of the window.

If Source is specified, the width and height of the source are used as the aspect ratio.

All the values are optional but the commas must be used.

-Caption=

Set the caption of the window. To include spaces, enclose the string in double quotes (").

-ShowFrameRate={On|Off}

Display or remove the current frame rate in the title bar,

-ShowMenuBar={On|Off}

Use to specify if the menu bar is to be displayed.

-Window=[top],[left],[width],[height]

Change the position and size of the window.
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All the values are optional but the commas must be used.

-WindowStyle={BorderAndTitleBar|BorderOnly|NoBorderOrTitleBar}

-ExcludeBorders={On|Off}

-DisplayMessageAfter=time in milliseconds

-CaptureFormat={Automatic|5-5-5|5-6-5|8-8-8}

-TransferData={ViaSystemMemory|DirectToGraphicsCard}

-Scaling={Fast|Slow}

-ActiveCaptureRate=percentage

Select one of the following percentages: 1, 5, 10, 15, 20, 25, 33, 50 or 100. If you use a number that is not in the list, it will
be rounded down to the closest number lower in the list.

-InactiveCaptureRate=percentage

Select one of the following percentages: 1, 5, 10, 15, 20, 25, 33, 50, 100. If you use a number that is not in the list, it will
be rounded down to the closest number lower in the list.

-DifferentCaptureRate={On|Off}

-Input=input number

-Reset

Discards the capture settings for the mode the Vision source is currently generating.

-ShareCaptureSettings={On|Off}

With ShareCaptureSettings switched on, the changes made to the capture settings controls are shared with other Vision
windows. The capture settings are saved automatically so that the next time a Vision window is created, the capture
settings can be used.

With ShareCaptureSettings switched off, the changes made to the capture settings controls are applied to this Vision
window only.

When switching ShareCaptureSettings on, the capture settings for the Vision window will be discarded.

By default, ShareCaptureSettings is switched on.

-Cropping=[{On|Off}],[top],[left],[width],[height]

-Deinterlace={Weave|Bob|Field0|Field1}
 

Select Weave for sources with little or no motion.
 

Select Bob for sources displaying motion.
 

Select Field for a single field to be displayed.

The following command line options allow changes to the appearance of the Vision source. The numbers correspond to the
values displayed on the Input Settings sheet.

-CaptureWidth=number

-CaptureHeight=number

-HorizontalPosition=number

-HorizontalSize=number

-Phase=number

-VerticalPosition=number

-BlackLevel=number

-Brightness=number

-Contrast=number
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-Saturation=number 

-Hue=number

-Rotation={0|90|180|270}

Sets the orientation for the current input signal.

-Information

Creates a text file called information.ini in the current directory. The file contains details of the minimum and maximum
values and supported features that can be used with the command line.

The information.ini file is over written every time the –information is used.

-CursorStyle=Show  

Always shows the cursor within the client area of the window

-CursorStyle=Hide

Always hide the cursor within the client area of the window

-CursorStyle=HideWhenActive

Only hide the cursor within the client area of the window when the window is the active window on the desktop.

Networking Options

To control a window on a machine other than the one you are working on you will need some of the following options:

-Machine={machine name|IP address}

Use this option to specify the machine to connect to.

-Port=port number

You need specify the port if you are attempting to control a window on another machine and the Vision server has been
configured to listen on a port other than the default port 1049.

A port number is any integer between 1 and 65535.

If the server requires a User Name and Password, the following options should be used:

-UserName=user name

-Password=password

If the machine is not participating in a domain, the account must be on the machine you are connecting to.

If the machine is participating in a domain you have a choice:

The account can be on the machine you are connecting to.

It can be an account on the domain.

If the account is on the domain, the domain name must be specified with the following option:

-Domain=domain name

On Screen Display (OSD)

Click here for OSD Command Line Interface
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Application
The command line interface allows you to create, modify or close Application windows.

The command line interface can be accessed in a number of ways:

From a shortcut specifying APPCMD.EXE as the target followed by the command line options separated by spaces.

From a command prompt by specifying the full path of APPCMD.COM or by having the folder where the Wall Control
software was installed on the path.

From a batch file. The same rules as command prompt apply.

Example Usage

Open the application ‘notepad.exe’ to display the file “c:\info.txt”.

"C:\Program Files (x86)\Wall Control\appcmd.exe" -AppName=”notepad.exe” -CmdArgs=”c:\info.txt”

Open the Internet Explorer application ‘iexplore.exe’with the URL “http://www.google.com” and assign the ID 1.

"C:\Program Files (x86)\Wall Control\appcmd.exe" -AppName=”C:\Program Files\Internet Explorer\iexplore.exe” -
CmdArgs=”-nomerge http://www.google.com” -ID=1

Move the application window with the ID 1 to the origin of the desktop without changing its size.

"C:\Program Files (x86)\Wall Control\appcmd.exe" -ID=1 –Window=0,0,,

Close the application with the ID 1.

"C:\Program Files (x86)\Wall Control\appcmd.exe" -ID=1 -Close

Nomenclature

Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

-ID=number

When a window is created it can be allocated an ID. To modify or close a window, specify its ID so the correct window is
modified or closed.

An ID is any integer between 1 and 65535. The ID is specific to Application windows.

-Close 

If this command line option is specified with an ID, the window with that ID is closed.

-ShowState={Minimised|Restored|Maximised|Show|Hide}

Sets the show state of the window.

To activate a window use Restored.

-AlwaysOnTop={On|Off}

-ShowMenuBar={On|Off}

Use to specify if the menu bar is to be displayed.
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-Window=[top],[left],[width],[height]

Change the position and size of the window.

All the values are optional but the commas must be used.

-WindowStyle={BorderAndTitleBar|BorderOnly|NoBorderOrTitleBar}
 

-AppName=”application name”

The full path of the application must be specified.

-CmdArgs=” Command line arguments”

Specifies optional parameters for the application. Many applications accept the name of a file to be opened. For details of
command line arguments, refer to your application documentation.

-CmdArgs can only be used with -AppName.

-StartDir=” Start in folder”

The Start in folder is the folder in which the application is run.

If a Start in folder is not specified, the application will run in the folder in which it resides.

-StartDir can only be used with -AppName.

Networking Options

To control a window on a machine other than the one you are working on you will need some of the following options:

-Machine={machine name|IP address}

Use this option to specify the machine to connect to.

-Port=port number

You need specify the port if you are attempting to control a window on another machine and the Application server has been
configured to listen on a port other than the default port 1049.

A port number is any integer between 1 and 65535.

If the server requires a User Name and Password, the following options should be used:

-UserName=user name

-Password=password

If the machine is not participating in a domain, the account must be on the machine you are connecting to.

If the machine is participating in a domain you have a choice:

The account can be on the machine you are connecting to.

It can be an account on the domain.

If the account is on the domain, the domain name must be specified with the following option:

-Domain=domain name
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On Screen Display
Nomenclature
Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

-OSDType={Disabled|SimpleText}

Switches the OSD on or off

-OSDText=

Specifies the on screen display text.

If the text includes spaces, the text must be enclosed in double quotes.

Line breaks are indicated by the characters \n. If you wish to include a \ in the text, it must be preceded by a \.

For example -OSDText=”The quick\nbrown fox\njumps over\nthe lazy dog.” Gives the on screen display:

The quick

brown fox

jumps over

the lazy dog

-OSDScaling={FixedSize|ScaleWithWindow}

Allows you to specify how the OSD is scaled. When FixedSize is specified, the OSD is displayed at the same size
regardless of the size of the window. When ScaleWithWindow is specified, the OSD is scaled up or down according to
the size of the window.

-OSDFontName=font name

Specifies the name of the font to be used for OSD text. If the font name includes spaces, the name must be enclosed in
double quotes.

-OSDFontSize=number

Specifies the point size of the font to be used for OSD text.

-OSDFontStyle={Regular|Bold }

-OSDFontItalic={On|Off}

-OSDFontStrikeout={On|Off}

-OSDFontUnderline={On|Off}

-OSDFontColour=red,green,blue

Specifies the colour of the text in red, green and blue components. Each of the components is a number from 0 to 255.

-OSDBackground={Transparent|Opaque}

When Transparent is specified, the Vision capture in the area behind the text is visible.

When Opaque is specified the area behind the text is displayed in the colour specified using the OSDBackgroundColour
option.
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option.

-OSDBackgroundColour=red,green,blue

When OSDBackground is set to Opaque, this option specifies the colour displayed behind the text in red, green and blue
components. Each of the components is a number from 0 to 255.

-OSDMargins=[top],[left],[right],[bottom]

The margins define the area in which OSD is displayed.

If ScaleWithWindow is specified, the margins are measured in pixels of the Vision source. If FixedSize is specified, the
margins are measured in pixels of the interior of the Vision window.

Any part of the OSD that falls outside the margins is not displayed.

-OSDTextWrap={On|Off}

When text wrapping is switched on, if the text does not fit between the left and right margins, spaces between words are
replaced with line breaks to produce shorter lines.

When text wrapping is switched off, the text is displayed with the same spaces and line breaks as it has been entered.

-OSDHorizontalAlignment={Left|Centre|Right}

If you specify Left, the left edge of the OSD will be positioned against the left margin and each of the individual lines will
be left aligned.

If you specify Centre, the centre of the OSD will be positioned half way between the left and right margins and each of the
individual lines will be centred.

If you specify Right, the right edge of the OSD will be positioned against the right margin and each of the individual lines
will be right aligned.

-OSDVerticalAlignment={Top|Centre|Bottom}

If you specify Top, the top edge of the OSD will be displayed against the top margin.

If you specify Centre, the centre of the OSD will be positioned half way between the top and bottom margins.

If you specify Bottom, the bottom edge of the OSD will be displayed against the bottom margin.
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Audio
The Command Line Interface controls analogue, digital and line out audio streams.

The command line interface can be accessed in a number of ways:

From a shortcut specifying RGBXCMD.EXE as the target followed by the command line options separated by spaces.

From a command prompt by specifying the full path of RGBXCMD.COM or by having the folder where the Vision
software was installed on the path.

From a batch file. The same rules as command prompt apply.

 
Nomenclature
Italic - Information that you must supply.

Bold - Elements that you must type exactly as shown.

Ellipsis (...) - Parameter that can be repeated several times in a command line.

Between brackets ([]) - Optional items.

Between braces ({}) - Set of choices (separated by I) from which you must choose only one.

Courier font - Code or program output.

-AudioEnable={On|Off}

Enable or disable for the specified window.

-AudioFocusMute={On|Off}

Use to mute audio for the specified window unless it has focus.

-AudioLineOutMute={On|Off}

Mute line out in hardware.

-AudioLineOutGain=gain

Specify the numeric gain value to be applied to the line out.

-AudioLineOutSource={Digital|Analog}

Set line out source to as digital or analogue line out source .

-AudioDigitalMute={On|Off}

Mute digital input in hardware.

-AudioDigitalPair={0|1|2|3}

Select the stereo channel pair sampling for a digital input.

0: 0-1

1: 2-3

2: 4-5

3: 6-7

-AudioUnbalancedMute={On|Off}

Mute unbalanced input in hardware.

-AudioUnbalancedGain= gain
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Specify the numeric gain to be applied to the unbalanced input.

- AudioBalancedMute ={On|Off}

Mute balanced input in hardware.

-AudioBalancedBoost={On|Off}

Add a 20dB boost to the balanced input.

-AudioBalancedGain= gain

Specify the numeric gain to be applied to the balanced input.

-AudioADCMute={On|Off}

Mute the output mixer in hardware.

- AudioADCGain= gain

Specify the numeric gain to be applied to the output mixer.
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IP-Camera Troubleshooting
Common problems:

How to Configure the Test Camera

How do I make a new IP-Camera work with Wall Control-red?

The IP-Camera window displays the "No IP-Camera Feed" message

The IP-Camera window displays the message "Waiting For IP-Camera Feed"

The IP-Camera window displays the message "IP-Camera Feed Restarting"

The IP-Camera window displays the message "IP-Camera Feed Restart Failed"

The Render Station status displays the message "Flash Error"

The Render Station status displays the message "Screen Error"

The Render Station status displays the message "Error"

The Render Station status displays the message "Offline"

How do I control the IP-Camera’s resolution and frame rate?

The source resolution does not appear to be correct

The frame rate is lower than expected

What requirements should be considered when choosing a new IP-Camera that will work with Wall Control-red ?

 

How to Configure the Test Camera

Installed on the Render Station is a test camera that is used for testing the connectivity to the Render Station.

To display the test camera open the IP-Camera Configure dialogue and select the IP-Camera tab. Click on Add and the
following dialogue is displayed.
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In the Camera Name edit box type a camera name, for example "test camera"

From the Camera Model list scroll and select TEST MODEL

In the IP/Address/Host Name edit box insert "test.avi"

 
Click OK to complete the configuration.
 
The "test camera" will now appear in the Wall Control-red application toolbar and can be placed on the display wall to test
connectivity. If the test.avi file fails to display this indicates that there is no connection with the Render Station.

 

How do I make a new IP-Camera work with Wall Control-red ?

1.1) Most IP-Cameras provide a settings page that can be accessed via a web browser. You should use this settings page to
configure your camera to output an RTSP stream of the desired resolution. Refer to your manufacturer's documentation for
details on how to access this settings page. While configuring your IP-Camera you should make a note of the RTSP stream’s
path, if it is shown, because you may need this in step 1.3.

1.2) Configure your new IP-Camera.

1.3) Test the configured camera using the test button in the Configure IP-Camera dialogue.

Is your IP-Camera on the list of recommended models? If so please refer to the instructions here.

If you are not using one of the recommended IP-Cameras then you must first add a new model to Wall Control-red by following
the instructions here 1 before adding a camera by following the instructions here.

The IP-Camera window displays the "No IP-Camera Feed" message

Verify that you have followed the steps in 1.1 - 1.3 to test the connectivity and to configure the IP-Camera itself.

If the IP-Camera window was previously working correctly:

You may have exceeded the number of simultaneous connections to the IP-Camera. Try closing any other windows for
this camera.

The IP-Camera may have crashed. Try switching it off and then back on again.

If the IP-Camera window was not previously working:

Verify that the camera has been configured to use the correct model. It is unlikely that a camera will work with other
models, even if they are from the same manufacturer.

If the camera test in step 1.3 resulted in the message "Camera unreachable" then verify that the host name or IP address
is correct. If a host name is being used then check that the entire URL has not been entered instead. See Configuring
Cameras for an explanation of what this edit box should contain.

If the camera test in step 1.3 resulted in the message "Camera connection refused," verify that the port number is
correct. If the IP-Camera does not use the default RTSP port 554 then a camera port must be specifically configured in
Wall Control-red

Verify that the camera authorisation settings in Wall Control-red match those set up for the IP-Camera itself. Note that
some IP-Cameras have a default username and password.

Use the settings page described in step 1.2 to change the resolution of the camera’s IP stream. Try initially setting the
resolution to a low value and then increase it if this solves the problem.

Waiting For IP-Camera Feed

This message is briefly displayed during initialisation.

IP-Camera Feed Restarting

If the Render Station detects that an IP stream has stopped then this message is displayed while it attempts to restart the
stream. If this message occurs repeatedly then it may indicate an IP-Camera or network issue.

IP-Camera Feed Restart Failed

This message is displayed if the Render Station was unable to restart an IP stream. If this occurs then the test camera button
should be used to verify the connection.

The Render Station status displays the message "Flash error"
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Verify that the selected input is for a VisionRGB-E2 card. This error may indicate that a different type of Vision card is
being used.

Verify that the correct drivers are installed for the Vision hardware.

Verify that the correct DVI cables are being used to connect the Vision card to the graphics card on the Render Station
Ensure the cables have not been damaged and there is no visible corruption when using them with normal Vision
windows.

The Render Station status displays the message "Screen error"

Verify that the correct Vision input has been selected. If necessary, perform the configuration procedure again with the
Vision window open. The Vision window should automatically close when the input has been added.

Verify the Render Station's hardware, in particular the graphics card, meets the requirements set out in the setup guide.

Verify that the graphics card in the Render Station is using the correct native driver and not a default Microsoft driver.

Verify that the Render Station software has been installed as described in the setup guide and that the hardware
configuration has not been subsequently changed.

The Render Station status displays the message "Error"

Check the network connection between the Wall Control-red server machine and the Render Station. If the connection
has been interrupted then it may take twenty seconds or more to reconnect.

Verify that the Render Station machine is still switched on.

If directed by support staff, use the Reboot button to reinitialise the connection to the Render Station.

If none of these steps work then use the Remove button to de-configure the inputs. The configuration procedure should
then be performed again with the respective Vision windows open.

The Render Station status displays the message "offline"

Verify the network connection between the Wall Control-red server machine and the Render Station.

Verify the Render Station's IP address or host name is correct.

Use the Remove button to de-configure one or both of the Render Station's screens and then open the respective Vision
inputs. Verify that these inputs display the expected Render Station IP address and screen letter.

 

How do I control the IP-Camera’s resolution and frame rate?

Wall Control-red only acts as an IP-Camera viewer. In order to change the resolution of an IP-Camera you must use the
camera specific settings page described in 1.2.

The source resolution does not appear to be correct

Use the settings page described in step 1.2 to check that the IP-Camera window is displaying the expected IP stream.
Some IP-Cameras support multiple streams and allow their resolutions to be configured separately.

The frame rate is lower than expected

The source frame rate for IP-Cameras may be affected by multiple factors including:

Network bandwidth restrictions.

The number of simultaneous IP-Camera streams that are being used. - Due to the limitations of some IP-Cameras it
may be preferable to set up a server to re-stream a single IP-Camera input stream across the network to multiple clients
(see http://www.videolan.org/Val/streaming.html for an example). We are not responsible for the content of any external
web sites.

What requirements should be considered when choosing a new IP-Camera that will work with Wall Control-red ?

Wall Control-red is configured to provide support for a number of pre-configured IP-Cameras . These particular IP-Cameras
can easily be used with Wall Control-red by simply configuring the camera name and IP address. If other makes or models of
IP-Camera are used then the following requirements should be considered: 2
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Requirements for Wall Control-red compatibility:

RTSP support – Wall Control-red uses the network control protocol RTSP to communicate with the IP-Camera.
Therefore when choosing an IP-Camera you should ensure that it supports this protocol.

Non-proprietary video decoder or client support – Some IP-Camera manufacturers provide their own proprietary video
decoders and/or client software to decode and render the streams from their IP-Cameras. This effectively locks the IP-
Camera into using their decoder or client software. Wall Control-red decodes and renders the IP stream using a version
of the open source client VLC . It may therefore not be possible to decode the stream using VLC if it is in a proprietary
format. If in doubt consider asking the IP-Camera manufacturer whether they support video playback by non-proprietary
client software, including VLC.

 

1 This functionality is dependent on Wall Control-red licensing. Please contact support for further information. 

2 Support for non-recommended IP-Cameras cannot be guaranteed due to the use of proprietary formats and lack of standards between IP-Camera
manufacturers. If in doubt please contact support before purchasing an IP-Camera.
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Troubleshooting
Common Error Messages:

Access is denied

The RPC server is unavailable

The endpoint is a duplicate

The remote procedure call failed and did not execute

Changing Screen Resolution

Access is denied

This message means that the attempt to connect to the server application failed because the authentication information
provided was not acceptable.

One of the following has occurred:

The user name, the password or the machine/domain that you have entered are not correct. Try entering the details
again.

If the machine to which you are connecting is running Windows XP Service Pack 2 and you have not entered a
password, you will need to change your account so that you have a password.

If the machine you are connecting to is running Windows XP and it is not participating in a domain, you will need to
change the Network Authentication settings on the machine.

RPC Server unavailable

This message means that the attempt to connect to the server failed.

If you are connecting to My Computer:

Is the server application running?

Did an error occur that prevented the server application starting the RPC server?

Are you using the correct port name?

If you are connecting across a network:

Has the Wall Control-red server been activated? When Wall Control-red is installed on the server, a serial number must
be entered to enable the networking features.

If the server is running Windows XP Service Pack 2, is the firewall blocking the port for the server component? See
Windows XP Service Pack 2 .

Is the Wall Control-red server configured for network access? Security Policy

Is the server application running?

Did an error occur that prevented the server application starting the RPC server?

Are you using the correct port?

If a connection is possible with the Wall Control-red application either remotely or locally, you can use the Server Application
Manager dialogue to find out if the server application has been installed, is running and which port and port name it is using and
if an error occurred. In the Wall Control-red application, go to the Configure menu and select Server Applications.

If a connection is not possible with the Wall Control-red application, you will need to look at the application event viewer on the
Wall Control-red server.

The endpoint is a duplicate

This error message suggests that an attempt to open a communication port failed because it is already in use.

If the Wall Control-red server has not been activated or the networking has been disabled in the Wall Control-red Administrator
dialogue or Wall Control-red has not been activated, the problem is with the port name.
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dialogue or Wall Control-red has not been activated, the problem is with the port name.

If networking is enabled, the problem could be with either the port number or the port name.

You can find out the port number and the port name that the server application is using through the Server Application Manager
dialogue or the application event viewer.

You can find out which port numbers are in use on a machine with the netstat command. There is no way to find out which port
names are in use.

Use the Server Application Manager to change the port number and/or port name and restart the server application.

The remote procedure call failed and did not execute

This is displayed when trying to contact a server application that has been stopped after it had been connected to successfully.
Go to the Server Application Manager dialogue and start the server application again.

Changing Screen Resolution

Prior to making any changes to the resolution, it is recommended that the Vision server be stopped beforehand. This can be
done using the Server Application Manager dialogue.

The servers retain resources on the graphics card which my not be available if the resolution is changed.
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Event Viewer
Each of the server applications writes to the event log at following times:

When the server application is starting.

When the communications ports are opened.

When an error occurs. The message includes a description of the error.

When the server application is stopping.

To open the Event Viewer, select Administrative Tools from the Control Panel and click on the Event Viewer shortcut.

The information presented in the Event Viewer can be filtered for ease of use by selecting Filter from the View menu.
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